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Accurate means for predicting vehicle dynamics is required in the design and
testing of roadside safety hardware. Past research has used finite element (FE) modeling
to this end, but multibody systems (MBS) modeling may provide a more efficient way to
solve these problems. MBS modeling using Adams/Car was investigated by first
compiling an introduction to the program, then performing basic vehicle dynamics
simulations using a supplied model. Next, a model of a 2270 kg pickup was created and
validated against physical test data involving impact with a speed bump. Finally, pickup
trajectories in 4H:1V and 6H:1V V-ditches were predicted for widths of 24, 30, 38, and
46 ft.
A poor tire model and the inability to account for bumper contact led to
inaccuracies in the results, and guidelines are established for scaling damper rates to
compensate. For small obstacles and low impact scenarios, scaling damper rates by two
produces good results. As large tire deformations and bumper contact become important,
scale factors of 30 are required. Unfortunately, even high damper rates cannot fully
compensate for all factors. MBS modeling may prove useful in vehicle dynamics
simulations relating to roadside safety, but only for low impact events at least until a
better tire model can be acquired and bumper contact definitions can be included.
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1 INTRODUCTION
1.1 Problem Statement
Predicting vehicle trajectories and suspension dynamics is crucial for designing
and testing roadside safety systems, especially those placed on uneven surfaces. For
example, understanding the behavior of vehicles traversing depressed medians has
especially become important recently. Research has shown the vehicle-to-barrier
interface can greatly affect the performance of cable barriers in depressed medians or on
slopes as steep as 4H:1V [1,2]. This presents an important vehicle dynamics problem, the
solution to which could lead to better hardware designs and testing standards.
Midwest Roadside Safety Facility (MwRSF) at the University of NebraskaLincoln (UNL) has used FE simulations in LS-Dyna to predict vehicle trajectories in
medians, including with a 2270P pickup model [3]. Research at the National Crash
Analysis Center (NCAC), however, has chosen to use multibody systems (MBS)
dynamics modeling software to predict vehicle trajectories in median crossings [4,5,6].
No framework of previous MBS research in the area existed at MwRSF, prompting a
desire to pursue utilizing Adams/Car software [7] for vehicle dynamics simulations
ultimately relating to roadside barrier testing.
Adams/Car requires the user to be familiar with vehicle design and vehicle
dynamics concepts. Thus, any new user would benefit from an introduction to these
topics, which can be accomplished by running simulations of simple maneuvers in
Adams/Car using models already available in the software package.
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1.2 Objectives
The objective of this research was to provide a foundation for MBS dynamics
simulations at MwRSF by: (1) compiling and presenting information required to
introduce new users to Adams/Car modeling; (2) designing three simulations and
assignments for learning vehicle dynamics in Adams/Car; (3) creating a model based on
the NCAC 2270P FE pickup in Adams/Car; (4) validating the 2270P model against fullscale test data [13]; and (5) using the model to predict vehicle trajectories into V-ditches
with 4H:1V and 6H:1V slopes and widths of 24, 30, 38, and 46 ft for comparison with
previous LS-Dyna simulations [3].
1.3 Scope
First, a literature review was conducted to investigate MBS dynamics modeling,
its current applications in academia, and past V-ditch vehicle dynamics studies. Second, a
brief introduction to components and terminology was presented as Adams/Car assumes
the user has a working knowledge of vehicle design. Third, three simulations and
associated assignments were created for use as a learning tool. Next, a model
representing the 2270P pickup was created, and the 2270P model was validated against a
full-scale speed bump test on a 2007 Chevy Silverado [13]. Model improvements were
made to better match the physical test data. Next, several simulations were performed to
investigate the bumper trajectory of the 2270P model in 4H:1V and 6H:1V V-ditch
medians of widths ranging from 24 to 46 ft. Results were compared to LS-Dyna
simulations of the same events. Finally, conclusions and recommendations were made for
improvements of the Adams/Car 2270P model for future vehicle dynamics research
relating to roadside safety systems.
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2 LITERATURE REVIEW
2.1 Brief History of Adams
Approximately 25 years ago, researchers at the University of Michigan developed
Adams (Automatic Dynamic Analysis of Mechanical Systems), a large displacement
code for solving systems of nonlinear numerical equations [9]. They formed Mechanical
Dynamics Incorporated (MDI) which was acquired by MSC.Software Corporation in
2002. Adams/Solver was first released as a program for solving nonlinear systems using
large displacement code. Models were initially built and submitted in text format. A
graphical user interface called Adams/View was released in the early 1990s to provide a
single environment for building, simulating, and examining results. Since then several
industry-specific products, including Adams/Car, have also been released. All products
are now available as part of the Adams Full Simulation Package. Adams/Car was used
for the vehicle dynamics simulations in this research.
2.2 Adams Applications in Academia
2.2.1 Student Design Competitions
Adams/Car simulations have appeared with increasing regularity in academia.
MSC Software, the owners of Adams, provide information and complete models for
student design competitions such as Formula SAE and Baja SAE. Universities worldwide
have utilized these resources in the development of their student competition vehicles
[10]. This research has led to technical papers on the subject concerning the effects of
chassis stiffness on a Formula SAE car [11]. In that study, flexible chassis parts were
included using Adams Flex, highlighting the capability of performing non-rigid-body
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dynamics modeling if needed. The study concluded the chassis stiffness must be a
multiple of the total suspension stiffness contrary to the previously-suggested method of
taking the difference between the front and rear suspension stiffness. In general, stiffer
chassis designs allow for easier optimization of vehicle handling balance.
The software has also been used for validating mathematical models regarding
roll-over of a Baja SAE vehicle [12]. Critical steer angles were investigated using
concepts presented by Gillespie for lateral acceleration gain with respect to steering and
the lateral acceleration limit relating to rollover. An Adams/Car model for the Baja
vehicle was analyzed to determine roll center and roll axis locations. Good correlation
between the resulting mathematical model and physical test results was found, however,
errors were observed and were attributed to using fixed rather than dynamic values for
the tire data. As will be shown during validation of the 2270P model, tire modeling
presents an area of great difficulty in vehicle dynamics modeling.
2.2.2 Multibody Systems Approach to Vehicle Dynamics
Vehicle Dynamics texts by Gillespie [13] and Milliken [14] are good references
for anyone looking for a thorough introduction to the subject. However, the multibody
systems (MBS) approach presented by Blundell and Harty [15] is helpful for those
specifically interested in vehicle dynamics modeling. They first present the theory behind
kinematics and dynamics of rigid bodies before introducing MBS simulation software
specifically relating to vehicle dynamics design. The text gives general information
related to most multibody dynamics software, but uses Adams for specific examples and
demonstrations. Concepts for building MBS models are presented including parts, joints,
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bushings, degrees of freedom, and forces. Introductions into solving linear and nonlinear
equations are also covered, albeit briefly.
Suspension systems are discussed by presenting the need for such systems to
allow for wheel load variations, body isolation, handling control, etc. Different styles of
suspension systems are shown using screen captures of templates in Adams/Car.
Suspension analysis is then covered by detailing the quarter vehicle modeling approach,
introducing how to determine suspension characteristics, and suspension calculations.
The chapter concludes with several case studies using Adams/Car simulations to
demonstrate the theories.
In similar fashion, tire modeling and full-vehicle assemblies are covered as well.
Simulation outputs and interpretation of data are also discussed, and the text concludes
with a chapter on active vehicle systems such as active dampers, brake-based systems
(antilock brakes), and active torque distribution (traction control).
The text could potentially be used in designing a Vehicle Dynamics course around
MBS modeling, however, the text does not include problems to be worked by students
similar to those in the Gillespie and Milliken texts.
2.3 The NCAC Pickup Model
The National Crash Analysis Center (NCAC) developed an FE model of a 2007
Chevy Silverado 1500 pickup [16], shown in Figure 2-1. The model consists of 929,131
elements and is adjusted to match the 2270 kg mass of the MASH-08 test level 3-11
vehicle. NCAC also performed full-scale suspension tests on an actual pickup by
traversing a speed bump at 16 km/hr [9]. Acceleration and deflection data in the
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suspension components were recorded, and the results from the test were used to validate
the suspension behavior in the FE model.

Figure 2-1 - NCAC FE model of a 2007 Chevy Silverado [16].

2.4 V-Ditch Simulations
Increased occurrences of cross-median crashes even when cable barriers were in
place prompted studies at NCAC funded by the Federal Highway Administration
(FHWA) [1,2]. Analysis of available crash data indicated that underride of the cable
barrier was possible for mid-sized sedans. Further analysis indicated possible override
with pickups after rebounding on the back slope of the median. More generally, it was
determined that the vehicle-to-barrier interface greatly affected the performance of the
systems in V-ditch medians. Initial FE simulations were conducted to predict vehicle
interface, however, the simulation time proved to be prohibitive by limiting the number
of parameters which could be investigated [2].
Vehicle dynamics analysis (VDA) was instead performed using HVE (Human
Vehicle Environment, The Engineering Dynamics Corporation) software. Simulations
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indicated that barrier placement 10 to 12 ft from the near edge of the median would
provide the worst case condition for override in the Dodge Ram 2270P pickup in MASH
test level 3 tests [6].
MwRSF performed similar trajectory simulations using LS-Dyna [3] and
developed proposed test matrices for new federal standards. Tests were conducted using
the 820C, 1100C, 1500A, 2000P, and 2270P vehicle models for 4H:1V and 6H:1V slope
V-ditches of varying widths. Trajectories of the vehicles were plotted by tracing a critical
point on the front bumper. Maximum and minimum bumper heights at critical locations
were found with respect to the median surface to find the worst case conditions for
possible override and underride of a cable barrier. At each location, the 4H:1V sloped
medians presented the worst case scenario for override and underride of the 2270P
vehicle.
For the 2270P pickup, a maximum height of 45.9 inches at 12 ft from the front
slope break point (SBP) was found for 4H:1V, 24 ft wide medians. For medians widths
greater than or equal to 30 ft, a maximum height of 46 inches at 12.6 ft from the front
SBP was found. This condition presented the worst case condition for vehicle override on
the front slope.
A minimum bumper height of 2.4 inches was recorded 4.1 ft from the bottom of
the ditch when testing in the 46 ft wide median, indicating the worst case condition for
possible underride on the back slope. Rebounding on the back slope of the median
presented a second location for possible vehicle override. The worst case here indicated a
maximum bumper height of 37.9 inches observed 5.6 ft from the back slope break point
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(SBP) in the 38 ft wide median. A summary of the maximum and minimum bumper
heights for each median width is provided in Tables 2-1 and 2-2.
Table 2-1 - Critical Bumper point locations for 2270P vehicle in 4H:1V medians, [3].
Critical Bumper Point

24 ft wide

Height (in.) [Location (ft)]
30 ft wide
38 ft wide

46 ft wide

Max Height, Front Slope
[loc. from front SBP]

45.9 [12.0]

46.0 [12.6]

46.0 [12.6]

46.0 [12.6]

Min Height, Back Slope
[loc. from bottom of ditch]

6.6 [7.1]

5.7 [6.2]

4.0 [5.1]

2.4 [4.1]

Max Height, Back Slope
[loc. from back SBP]

32.4 [0.0]

37.0 [0.1]

37.9 [5.6]

37.8 [7.4]

Height @ 4 ft from Front SBP

36.7

36.7

36.7

36.7

Max Height, 0-4 ft from Back
SBP [loc. from back SBP]

32.4 [0.0]

37.0 [0.1]

37.6 [2.5]

35.4 [4.0]

SBP = slope break point
Table 2-2 - Critical Bumper point locations for 2270P vehicle in 6H:1V medians, [3].
Height (in.) [Location (ft)]
30 ft wide
38 ft wide

Critical Bumper Point

24 ft wide

Max Height, Front Slope
[loc. from front SBP]

35.3 [8.8]

35.3 [8.8]

35.3 [8.8]

35.3 [8.8]

Min Height, Back Slope
[loc. from bottom of ditch]

9.3 [2.7]

8.4 [4.9]

9.4 [4.2]

11.8 [5.2]

Max Height, Back Slope
[loc. from back SBP]

29.3 [0.0]

32.4 [0.5]

30.2 [2.5]

34.1 [6.0]

Height @ 4 ft from Front SBP

32.7

32.7

32.7

32.7

Max Height, 0-4 ft from Back
SBP [loc. from back SBP]

23.9 [0.0]

32.4 [0.5]

30.2 [2.5]

32.8 [4.0]

SBP = slope break point

46 ft wide
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From the critical bumper heights, test matrices were developed to describe the
worst case conditions for vehicle override or underride of cable barrier systems in three
different configurations: (1) single median barrier placed anywhere in the median; (2)
single median barrier placed at a 0-to-4 ft lateral offset; and (3) double median barriers
placed at 0-to-4 ft offset.
2.5 Literature Summary
MBS dynamics software is already being used for applications in academia via
simulations for student design competitions such as SAE Formula and Baja. There are
also opportunities for incorporating MBS modeling into Vehicle Dynamics courses using
texts developed around these methods.
Research suggests that the vehicle-to-barrier interface plays a critical role in
determining the performance of cable barriers placed on sloped surfaces or in depressed
medians. Current federal standards do not include tests for systems placed on sloped
surfaces. Attempts have been made to develop testing standards for these situations, with
simulations of vehicle dynamics playing an important role. Worst case scenarios for
override for the 2270P pickup exist on the front slope after the vehicle has left the
roadway and on the back slope after rebounding. Possible underride occurs on the back
slope after the vehicle impacts the ground. MBS modeling greatly reduced computation
time compared to FE modeling allowing for multiple test scenarios to be simulated in a
relatively short time.
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3 INTRODUCTION TO VEHICLE COMPONENTS
Adams/Car is a sophisticated enough software to accurately model complete
vehicle subsystems, and assumes the user has at least a basic working knowledge of
actual vehicle systems. This knowledge is in fact required to successfully build,
assemble, and test vehicle models in Adams/Car. A brief overview including terminology
and comparisons to Adams/Car subsystems is provided here for the novice car guys.
As in a real vehicle, an Adams/Car model consists of multiple subsystems, of
which many are possible in the program. Most, but not all, are required when attempting
to run simulations. Typical subsystems used in Adams/Car full vehicle models are:


Chassis



Front suspension



Rear suspension



Steering



Front wheel



Rear wheel



Brake



Powertrain
Each of these will be covered in detail using figures of real vehicles when

possible.
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3.1 Chassis
A vehicle chassis is the underlying structure, often made of steel, upon which the
remaining parts and systems of the vehicle are built. Most modern passenger cars utilize a
monocoque or unibody design where the chassis is integrated and assembled with the
body of the car. Conversely, most modern pickups still use a separate frame, or body-onframe design, as shown in Figure 3-1. For ease of assembly, most vehicles also
incorporate removable subframes, typically for mounting suspension or drivetrain
components, and these are assumed to be part of the chassis as well.

Figure 3-1 - This 1994 Ford Mustang GT (left) utilizes a unibody chassis design,
while the 2001 Ford F250 (right) uses a body-on-frame design.

12
Most, but certainly not all simulations in Adams/Car are performed assuming only
rigid body mechanics with the exceptions for bushings, springs, dampers, and tire
models. All other components, such as the chassis, are not allowed to flex. In the case of
real unibody designs, the chassis flexes very little in normal driving events. However, in
frame-on-body designs, especially with long wheelbases (the distance between the front
and rear axles), some flex is normal. Adams does allow for the use of flexible bodies if
necessary.
Finally, for Adams/Car models, the mass and inertia properties of the vehicle
chassis include all parts not associated with other subsystems. For instance, the weight of
all body panels, interior components, wiring, etc. must be included in the mass properties
of the chassis.
3.2 Suspension Subsystems
All vehicles on the road today are equipped with some kind of suspension system.
Gillespie [13] presents that the primary functions of suspension systems are to:


Provide vertical compliance allowing wheels to follow uneven roads while
isolating the chassis from noise, vibration, and harshness;



Maintain steering and camber geometry with respect to the road surface;



Transmit tire forces to the chassis: longitudinal (acceleration/braking) forces,
lateral (cornering) forces, and braking and driving torques;



Resist body and chassis roll;



Keep tires in contact with the road surface with minimal variation in load.
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Several suspension system designs exist in vehicles on the road today, but most
can be grouped into either solid axle or independent systems. Example suspension types
included with the Adams/Car software package are shown in Figure 3-2. In the truck
model analyzed later in this report, the front suspension utilizes an independent, double
wishbone (SLA, double A-arm) design while the rear suspension uses a Hotchkiss solid
axle which is not included in the <acar_shared> database.

Figure 3-2 - Suspension types included with Adams/Car.
3.2.1 Key Parameters
Three key suspension parameters contribute significantly to the handling
characteristics of a vehicle: caster, camber, and toe, shown graphically in Figure 3-3.
Caster is the angle between the vertical axis and the steering axis when viewing the
vehicle normal to one of the sides. Positive caster means the steering axis is tilted toward
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the rear of the vehicle. Camber is the angle between the vertical axis and a line parallel to
the vertical sides of the wheel. Negative camber means the top of the wheel is tilted
inward towards the vehicle. Toe is the angle between the longitudinal axis a line parallel
to the longitudinal sides of the wheel. Negative toe (or Toe In) means the tires are tilted
slightly inward towards the centerline of the vehicle.
Typical suspensions are set up similar to what is shown in Figure 3-3, though they
are exaggerated for visual purposes. Positive caster and negative camber and toe are
preferred for predictable behavior both during straight line motion and in cornering.
Negative camber aids the outside tire in generating higher lateral forces during cornering,
and negative toe adds stability since suspension components are much stronger in
compression than in tension. If positive toe were used, the tires would generate forces
away from the center of the vehicle during straight forward motion, adding unwanted
stresses and possible steering instability. Suspension systems must control these
parameters during deflection and rebound to maintain vehicle stability over obstacles or
rough terrain.
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Figure 3-3 - Caster, camber, and toe.

3.2.2 Double Wishbone Suspension
Adopting the Adams/Car naming convention, the term double wishbone is used to
describe any suspension composed of independent, upper and lower control arms
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suspended by a coil spring and controlled by a damper, as shown in Figure 3-4. This style
of suspension has become very common in modern cars for its good handling and control
characteristics.

Figure 3-4 - Major components of a Double Wishbone suspension.
Upper and lower control arms (A-arms) attach at inner joints to the chassis
subframe, via pliable bushings. Outer joints on the control arms control the knuckle,
where the brake rotor and wheel are mounted. All driving forces are transmitted to the
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chassis through the control arms. An anti-sway bar links the left and right lower control
arms to prevent excessive body roll during cornering.
In front suspension applications, ball joints are used to mount the knuckle. A line
passing through these ball joints defines the steer angle about which the knuckle rotates.
This line, when viewed from the side, also defines the caster angle. Tie rods transmit
steering inputs to the suspension, and connect at inner joints to the steering rack (part of
the steering subsystem) and to the knuckle at outer joints. In rear suspension applications,
the outer control arm joints are fixed and no tie rods are used.
A primary advantage of independent suspensions, such as the double wishbone
design, is the careful control of suspension geometry throughout the full range of motion.
Even during opposite wheel travel, wheel position with respect to the ground is well
controlled, as shown in Figure 3-5.

Figure 3-5 - Double wishbone suspension behavior under opposite wheel deflection.
3.2.3 Hotchkiss Straight Axle
Differing significantly from the independent design, the Hotchkiss suspension
uses a straight axle suspended by leaf springs, as shown in Figure 3-6. Chosen for its
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robust design, particularly with drive axles, this style is typically used in pickups and
large trucks. Fewer moving parts simplify the design at the expense of reduced control
over geometry during suspension deflection.

Figure 3-6 - Hotchkiss solid axle suspension.
A solid axle is suspended by semi-elliptical leaf strings, which also locate the rear
axle under the vehicle and transmit driving forces to the chassis. They combine the
responsibilities of the coil spring and control arms in independent systems. Springs are
attached to the frame via bushings in the front and a shackle link in the rear. As the
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springs deflect, their length changes and the shackle rotates to accommodate. Rubber
bumpstops limit suspension travel to prevent the axle or wheels from contacting the
frame or body.
Commonly used in rear drive applications, a center differential transmits power
from a drive shaft (part of the powertrain) to the wheels through axle shafts which spin
inside structural axle tubes. Wheels and brake rotors or drums are mounted directly to
hubs attached to the end of the axle shafts. Thus in non-steering applications, this design
does not allow for camber or toe angles since the wheels always remain perpendicular to
the axle. Hotchkiss suspensions can, however, also be used in front suspensions by
adding tie rods and a knuckle attached via ball joints to the ends of the structural axle
beam or tube. U-joints attach the front spindle to the drive axles in four-wheel-drive
applications.
In contrast with independent suspensions, solid axles do not allow for the same
level of geometry control. During opposite wheel travel, non-steer axles require that the
wheels remain perpendicular to the axle, as shown in Figure 3-7.

Figure 3-7 - Hotchkiss solid axle under opposite wheel travel.
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3.3 Steering
No vehicle can be properly controlled without a steering subsystem. A proper
steering system must link the front two wheels, maintain a proper amount of toe, and
produce correct steer angles when corning. Gillespie [13] defines the important geometry
of a turning vehicle, as shown in Figure 3-8.

Figure 3-8 - Geometry of a turning vehicle (image from Gillespie, [13]).
Note that as the vehicle completes a turn, the inside steer angle must be larger
than the outside steer angle to follow the radius of the turn without subjecting the tires to
excessive side slip and premature wear. Proper steering geometry provides desired
steering feedback to the driver where the steering torque increases with steer angle. If the
front wheels remained parallel during a turn, steering torque would increase initially
before dropping off and possibly becoming negative as steer angles increase. A negative
steer torque would cause the vehicle to automatically steer further into a turn, creating a
dangerous loss of control.
Many styles of steering systems exist, but the two most common are Pitman Arm
and Rack-and-Pinion designs. Pitman arms, as shown in Figure 3-9, are typically used in
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heavy trucks and pickups with straight axles, while rack-and-pinion systems are used
nearly everywhere else. Both designs can be equipped with either hydraulic or more
recently offered electric power assist systems.

Figure 3-9 - Pitman arm steering design on a 2001 Ford F250.
A steering box transmits driver inputs to the Pitman arm that rotates through an
arc to move the draglink which is attached near one end of the tie rod. Each end of the tie
rod attaches to the knuckles to control steering geometry. A steering stabilizer is typically
added in larger pickups for added control in the system. Since the steering box can be
mounted to the frame above the axle, the Pitman design lends itself well to use in straight
front axle suspensions. Conversely, the rack-and-pinion design utilizes a central rack that

22
must be mounted to a subframe inline with the tie rods and much closer to the ground, as
shown in Figure 3-10.

Figure 3-10 - Major components of a rack-and-pinion steering system on a 1994
Ford Mustang GT.
Steering inputs turn a pinion gear against the steering rack which moves a rack
left or right. Tie rods connect to the rack via ball joints and transfer steering forces to the
knuckles. Since subframes required to mount the lower control arms provide convenient
mounting locations for the fixed rack housing, rack-and-pinion steering designs are
commonly used with independent suspensions. The components of the Adams/Car rackand-pinion steering system are shown in Figure 3-11.

Figure 3-11 - Adams/Car rack-and-pinion steering system components.
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3.4 Wheels and Tires
Nearly all normal driving forces applied to a vehicle, with only the exception of
aerodynamic drag, are generated by the interaction between the tire contact patch and the
ground. Thus, wheels and tires directly affect handling, ride, braking, and accelerating
characteristics.
Tire lateral forces are created as lateral slip angle is increased, as shown in Figure
3-12. At small slip angles, the relationship is linear, and is characterized by the cornering
stiffness, Cα, or the slope of the lateral force curve vs. slip angle at α = 0 (or small slip
angles). As shown in Figure 3-12, a negative slip angle produces a positive lateral force
(to the right). SAE convention defines the cornering stiffness as the negative of the lateral
force slope, thus Cα is positive.

Figure 3-12 - Tire lateral force vs. slip angle (image from Gillespie, [13]).
Normal loads have a great effect on the lateral force vs. slip angle behavior of
tires, so it is important to also introduce the cornering coefficient, CCα, which is the
cornering stiffness divided by the normal tire load [13]:
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(3-1)

In general, the cornering coefficient is highest at light loads (small Fz) and diminishes as
the load rating is reached. Typical values for CCα at 100% rated load is around 0.2 (lbylbz/deg α). Tire and wheel main components are shown in Figure 3-13.

Figure 3-13 - External tire and wheel components.
Making up the largest portion of the tire, the tread is designed to effectively retain
grip with the ground under varying situations. Much design work goes into creating tread
patterns specialized to shed water, grip on mud, ice, or snow, or maximize adhesion to
dry roads. Steel belts are molded into the tire beneath the tread for strength. Aptly named,
the sidewall makes up the distance between the rim and the tread. The material here can
be made softer for better ride quality, or stiffer for less lateral distortion and better
handling. Cords, typically made of nylon or steel, are molded into the sidewall to add
strength and flexibility. A steel-cable-reinforced bead secures and seals the tire to the
wheel. Wheels (rims) are typically made from either steel or aluminum and come in a
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variety of sizes for different applications. Lug nuts hold the wheel to the knuckle, spindle,
or hub, depending on the application.
Tire sizes, speed, and load ratings follow an industry standard, and are printed on
the sidewall, as shown in Figure 3-14. The first number indicates the section width (the
widest portion of the tire) in mm. The second number is called the aspect ratio and is the
ratio of the section width to section height. In this case, the 'Z' indicates part of the speed
rating. The third number, following the 'R,' indicates the diameter of the rim in inches.
The final number and letter indicate the load and speed rating for the tire, respectively.
The overall tire dimensions are shown in Figure 3-15.

Figure 3-14 - Tire size as printed on sidewall.
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Figure 3-15 - General tire dimensions.
For vehicle dynamic modeling purposes, the wheel is modeled as a rigid body, but
proper tire deformation behavior must be considered. Adams/Car includes several basic
tire models in the standard simulation package.
3.5 Brakes
A 3500-lb car traveling at 75 mph generates over 657,000 ft-lb of kinetic energy,
requiring a sufficient braking system capable of dissipating that energy quickly if
necessary. Most current brake systems operate by using mechanical friction to input a
braking torque to the wheels. Though still used in some cases today, drum brakes are an
old design. A steel drum encases a mechanical system which expand to press two shoes
against the inner diameter of the drum when activated. Special friction material in the
shoes create large amounts of friction when forced outward against the drum.
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Beginning around the 1960s, the disc brake design, shown in Figure 3-16, began
to be implemented on cars and trucks. Very gradually, over the course of decades, drum
brakes were phased out of use in favor of disc brakes for most passenger cars and
pickups. As performance of cars, and weight capacities of pickups, have increased over
the years, disc brakes have become larger and more robust. Vented rotors are now
common for dissipating the large amount of heat generated by the brake pad friction.
Road course and speedway racecars even incorporate cooling ducts to direct air over the
rotors to provide better heat transfer.

Figure 3-16 - Major components of a disc brake system on a 2001 Ford F250.
When the driver presses the brake pedal, it pressurizes the brake lines via a small
pump called a master cylinder. This pressure causes cylinders inside the brake calibers to
exert force on brake pads housed inside. As the brake pads are clamped down against
both sides of the brake rotor, friction forces are created with increasing strength
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depending on the pressure in the brake lines. To provide good feedback to the driver, a
linear increase in braking force with pedal position and pedal force is desired.
When wheels are installed on the wheel studs, the brake rotor is clamped to the
entire rotating system which includes the axle shaft in applications similar to what is
shown in Figure 3-16. In this manner, braking torques oppose the rotational motion of the
wheel to create resulting braking forces in the tire contact patch.
3.6 Powertrain
Propelling a vehicle forward requires the generation and transmission of power.
These duties are handled by the powertrain which typically consists of an internal
combustion engine, a transmission, and either a driveshaft or half shafts. A rear wheel
drive pickup includes the components shown in Figure 3-17.

Figure 3-17 - Rear wheel drive pickup drivetrain.
Most of the power produced by the engine is sent through a transmission with
variable speeds to spin a driveshaft transferring the power back to the rear axle
differential and to the wheels. Some power is used to drive accessories mounted on the
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front of the engine. These include an alternator for charging the electrical system, a water
pump to circulate engine coolant, a power steering pump, and an air conditioning
compressor. Transmissions can be manually or automatically shifted. Some front drive or
rear-engine vehicles have a transaxle that combines the transmission gears with the
differential. Half shafts transfer power directly from the transaxle to the wheels or from a
central differential to the wheels in rear wheel drive, independent suspension systems.
As with actual vehicles, Adams/Car powertrains require engine power curves,
transmission gear ratios, and driver inputs (accelerometer and clutch activation) to
function, although some simulations may be run without a powertrain.
3.7 Summary
As vehicle models are introduced in the following sections, these terms and
parameters will continually come into play. Adams/Car models are constructed in much
the same way as real vehicles. Individual subsystems are assembled together to create a
complete vehicle model. The choice of suspension geometry, mass properties, spring
rates and damper rates all can have a profound impact on the characteristics of the model.
Thus great care is required to create a meaningful model capable of producing useful
results.
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PART I: VEHICLE DYNAMICS COURSEWORK
4 INTRODUCTION TO ADAMS/CAR: THE MDI DEMO VEHICLE
Although the visual design is that of an exotic sports car, the MDI Demo Vehicle
included in the Adams/Car software package provides a fully functional vehicle model
for those not interested in building their own model from the ground up. Using this
vehicle and its subsystems, the model hierarchy and parameters specific to Adams/Car
will be introduced. Subsequent sections will utilize the model for basic vehicle dynamics
demonstrations to be used in conjunction with a course in the same subject matter.
4.1 Introduction
Adams/Car contains fairly comprehensive help features which contain good
information for those new to the software. However, several initial set up procedures and
common input values need to be covered in greater detail. Adams/Car help does contain
more information relating to the concepts and terms introduced here if clarification or
other options are desired.
Adams/Car uses two separate graphic user interfaces plus a post-processor. The
first interface is the Standard Interface, where subsystems and assemblies are created and
modified. This is also where simulations are set up and run, and by default is the first to
open when running the software. The second interface, the Template Builder, is only
accessible after modifying a configuration file, but is where vehicle templates are created.
The Adams/PostProcessor is where results data can be manipulated, plotted, and
compared. Videos of the test animations can be created from the PostProcessor as well.
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Adams/Car includes very thorough help menus accessible through the drop-down
menu at the top. There are two slightly different help menus, Adams Help and
Adams/Car Help. When a popup window is open and active, pressing the 'F1' key
launches a help menu specific to that window.
4.1.1 Initial Set Up
To begin, an Adams/Car configuration file (acar.cfg) must be modified to operate
in "expert mode" allowing access to the Template Builder. Without performing this
change, Adams/Car by default will only allow access to the Standard Interface. This file,
an excerpt from which is shown in Figure 4-1, is usually located in the acar directory
among the MSC.Software program files. An example directory path would be:
C:\MSC.Software\MD_Adams_x64\2011\acar\acar.cfg.
Change the 'MDI_ACAR_USERMODE' from 'standard' to 'expert' to allow use of
the Template Builder and save the file. Upon running Adams/Car after modifying this
file, the opening dialogue box gives the option of operating in the Standard or Template
Builder Interface. Once open, pressing the 'F9' key toggles between these two.

Figure 4-1 - Adams/Car configuration file. Red circle and arrow indicate required
modification to gain access to the Template Builder.
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Prior to running any simulation, one must select the working directory, where all
simulation and results files will be stored. By default, all files will be saved to the
desktop, so this step is important for organizational purposes. The directory is selected
via the 'File' menu → Select Directory...
Databases are frequently used in Adams and contain all the files required for a
model except simulation results files which are written to the working directory. For
organizational purposes, the suggested practice is to create a new database for each
model. See Adams/Car Help topic "Configuring Your Product" → "Managing
Databases." The folders in a typical Adams/Car database are shown in Figure 4-2.
Included in the software package is the <acar_shared> database which contains
demonstration subsystems, assemblies, and associated property files.

Figure 4-2 - Database folder list.

4.1.2 Common Interface Features
Several drop down menus along the top of the window are available in each
interface. The coordinate triad is located in the lower, left-hand corner. In the lower,
right-hand corner, four box icons are available, as shown in Figure 4-3. The first is a
general select button bringing up a standard selection arrow if it is not currently available.
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The database navigator provides a tree-list of all available commands for the given
model. These commands are also typically located in the drop-down menus at the top, but
can be accessed from this single location if desired. Right-clicking on the Information
icon brings up four possible choices, as shown in Figure 4-3, and summarized in Table 41. The final icon stops the current command, including simulations, when possible.

Figure 4-3 - Adams/Car interface lower, right icon options.
Table 4-1 - Information Icon Options
List Information
(Database Navigator)
Model Topology by
Connections
Model Topology by
Parts
Verify Model, List
Parameters

Provides a tree-listing of all model objects, organized based on the
model hierarchy. List can be sorted or filtered and is used primarily
for finding information on a part or performing minor changes such
as renaming objects or adjusting their appearance.
Lists the objects in the model purely by their connectivity, typically
via joints or communicators. This is a straight list of connections,
not organized by part or subsystem.
Lists the individual parts in the model and the connections involved
with each part. Very similar information as the Model Topology by
Connections, but organized differently.
Lists and errors or warning associated with the objects in the
model.
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When creating or modifying certain components, three icons commonly appear,
as shown in Figure 4-4. Clicking the Comments icon allows the user to add notes to the
current object being created or modified. The Curve Manager icon launches the Curve
Manager window which allows the associated property file to be modified graphically or
via a table of values. For more information, see Adams/Car Help and search for "Curve
Manager." The last icon launches the Information Window and numerically lists the
values in the property file being used.

Figure 4-4 - Other common icons.
4.1.3 Naming Convention
Adams/Car uses a unique naming system for all objects in the model. A three to
six letter prefix is assigned to each object as it is created. The first two letters in the name
indicate the object type, and the third letter indicates left (l), right (r), or single (s).
Geometric objects are the only exception, and are always preceded by 'gra' followed by a
three-letter set to define the type of geometry. By default, any object created with a left or
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right dependency automatically creates a symmetric object with the same x and z
coordinates and the negative y coordinate. A summary of the object types with their
associated prefix is shown in Table 4-2. These prefixes are automatically added to the
user-inputted name when a new object is created.
Table 4-2 - Adams/Car naming conventions.
bg[lrs]_
bk[lrs]_
bu[lrs]_
cf[lrs]_
ci[lrs]_
co[lrs]_
css_
da[lrs]_
fb[lrs]_
ff[lrs]_
ge[lrs]_
gk[lrs]dif_
gk[lrs]red_
gp[lrs]_
gr[lrs]dif_
gr[lrs]red_
graarm
gracyl_
graell_
gralin_

Bushing (always active)

graout_

Outline geometry

Bushing (kinematically inactive)
Bumpstop (Adams/Car only)
Construction frame
Input communicator
Output communicator
Condition sensor
Damper (Adams/Car only)
Flexible body
User-function feedback channel
General part
Gear differential (kinematically
active)
Gear reduction (kinematically active)
General parameter
Gear differential (always active)
Gear reduction (always active)
Arm geometry
Cylinder geometry
Ellipse geometry
Link geometry

gs[lrs]_
gv[lrs]_
hp[lrs]_
ip[lrs]_
jf[lrs]_
jk[lrs]_
jm[lrs]_
jo[lrs]_
mt[lrs]_
nr[lrs]_
ns[lrs]_

General spline
General variable
Hardpoint
Interface part
Joint force actuator
Joint (kinematically active)
Joint motion actuator
Joint (always active)
Mount part
Nonlinear rod
Spring

ph[lrs]_
pt[lrs]_
pv[lrs]_
re[lrs]_
sw[lrs]_
ti[lrs]_
ue[lrs]_
wh[lrs]_

Hidden parameter variable
Point torque actuator
Parameter variable
Reboundstop (Adams/Car only)
Switch part
Tire force (Adams/Car only)
User-defined entity
Wheel part (Adams/Car only)

4.1.4 General Procedures
Some general procedures when working with the software:
1. Right-clicking in dialogue boxes brings up a list of options.
2. Right-clicking on parts/components shows more options.
3. Right-clicking the background lists view and rendering options.
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4. Pressing the 'v' key toggles the visibility of hidden objects including hardpoints,
joints, and construction frames among others.
5. The status bar at the bottom lists helpful information related to where the cursor
hovers over.
6. The 'F9' key toggles between the Standard Interface and the Template Builder.
7. The 'F8' key toggles between either the Template Builder or Standard Interface
and the Adams PostProcessor.
8. The 'F1' key accesses help menus specific to the currently active popup window.
For more information and an introduction to running simple simulations in
Adams/Car, there are several tutorials available in Adams Help → Getting Started →
Getting Started Using Adams/Car.
4.2 Model Hierarchy
Three specific categories construct any Adams/Car model: templates, subsystems,
and the full-vehicle assembly, as shown in Figure 4-5.

Figure 4-5 - MDI Demo Vehicle model hierarchy.
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Every vehicle model uses the same hierarchy. Templates are the building blocks
for the model, forming the foundation of each subsystem to be included. While every
subsystem requires a template, templates need not be unique to each subsystem. For
example, the double wishbone template defines the basic functionality of the suspension
style, but can be used for multiple models or multiple subsystems in the same model.
Vehicle-specific geometry, mass and inertia properties, and spring and damper rates can
all be uniquely defined at the subsystem level without forcing any changes on the
template. Finally, the complete set of subsystems is combined into the full-vehicle
assembly capable of being used in simulations. Suspension assemblies, for simulating
suspension responses to wheel travel or steering inputs, are also available when the
desired test does not require use of the full-vehicle assembly.
4.3 Coordinate Systems
Adams/View (the primary user interface in the Adams software package) defines
its global coordinate system using Cartesian coordinates. Adams/Car, being built upon
this interface, uses the same convention, as shown in Figure 4-6. The x-direction follows
the longitudinal centerline of the vehicle from front to back. Positive y-direction is in the
lateral direction to the right of the vehicle center. Positive z is in the vertical direction.
Local coordinate systems may also be defined for individual parts. Note, this coordinate
system is rotated 180 degrees about the y-axis from the SAE vehicle coordinate system.
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Figure 4-6 - Adams/Car global coordinate system.
4.4 Templates
Templates are the foundation of every vehicle model created in Adams/Car.
Several templates are included in the <acar_shared> database, shown in Figure 4-7. For
example, templates exist for each of the suspension types shown in Figure 3-2. Good
practice dictates using these existing templates when possible, and in fact if existing
templates can be used for the model being created, one does not need to access the
Template Builder at all. However, it is beneficial to step through the process of creating
and building a new template to understand the process and components involved.
Additionally, many of these steps can be used to modify existing templates when needed.

Figure 4-7 - Templates available in the <acar_shared> database.
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Activating the expert user mode (covered in Section 4.1.1) allows access to the
Template Builder, where users can begin building a model from the bottom up. To begin
creating a new template, one must first specify the major role for the system or
component being created. This choice activates system-specific parameters in the dropdown menus. For example, suspension templates contain menus for suspension-specific
parameters at the subsystem level which will only be accessible if the major role is
defined properly. Possible major role choices are:


Suspension



Powertrain



Environment



Steering



Driveline



Auxiliary Parts



Antirollbar



Brake System



Cab Suspension



Wheel



Leaf Spring



Cab



Body



Analysis

After setting the major role, the following components must be defined for each
template (if applicable): hardpoints, construction frames, parts, joints, bushings, springs,
dampers, and communicators. These items describe the geometry, mechanics, and
functionality of each vehicle subsystem. All components are created using the 'Build'
drop-down menu. These template components will be introduced in the following
subsections. Templates are saved to an associated folder in the default writeable database.
4.4.1 Hardpoints and Construction Frames
Before any other components can be created, important locations for the
subsystem must be defined using hardpoints. Typically used in defining part geometry,
these may also define locations for parts in other subsystems (for example wheel center

40
locations are specified in both the suspension templates and body templates using
hardpoints). The following is a list of harpoints in the double_wishbone suspension
template in the <acar_shared> database; their locations are shown in Figure 4-8:


hp[lr]_drive_shaft_inr



hp[lr]_subframe_front



hp[lr]_uca_front



hp[lr]_lca_front



hp[lr]_subframe_rear



hp[lr]_uca_outer



hp[lr]_lca_outer



hp[lr]_tierod_inner



hp[lr]_uca_rear



hp[lr]_lca_rear



hp[lr]_tierod_outer



hp[lr]_wheel_center



hp[lr]_lwr_strut_mount



hp[lr]_top_mount

Figure 4-8 - Hardpoint locations for the double wishbone suspension template.
Construction frames allow the user to define local coordinate systems and points
for part, mount, or joint orientations. Both hardpoints and construction frames are created
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by selecting the Build dropdown menu → Hardpoint(Construction Frame) → New... A
popup window provides necessary input parameters, as shown in Figure 4-9. Hardpoint
creation requires a name, type (left, right, or single), and location. Construction frames
require a name, type, location dependency, and orientation dependency. All three input
types are regularly required when defining other objects as well. Multiple options are
available for both the location and orientation dependency, and are based on hardpoint
locations, constructions frames, or other model points. See Adams/Car Help → Appendix
→ Summary of Location Dependency Options or Summary of Orientation Dependency
Options.

Figure 4-9 - Hardpoint and Construction Frame popup windows in Adams/Car.
Hardpoint locations are visible as green stars, and construction frames appear as a
three-axis triad. Both will have their individual names next to their graphics. Hardpoint
locations need not match a specific vehicle in the template and only need to provide the
general layout of the vehicle system being modeled. Hardpoint locations can be modified
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at the subsystem and assembly levels where the component geometry is finalized for the
specific vehicle. In this manner, a single template can be used for multiple subsystems.
Construction frames, however, can only be defined and modified in template files.
4.4.2 Parts
The next step in creating a template is to create and define parts. Parts use the
hardpoints and construction frames to define their position and orientation. While several
different types of parts may be created, general parts and mounts are most commonly
used. General parts form major system components such as control arms, driveshafts,
knuckles, and tierods in suspension systems, for example. For general parts, only the
center of mass, inertia properties, and material are required since rigid body motion is
assumed. These properties alone are sufficient for Adams to solve for the dynamics in the
system.
For visual purposes, however, simple geometry (links, cylinders, spheres, etc.)
can be created within Adams, or geometry files (IGES, STEP, etc.) can be imported for
more complex designs. Adams can also automatically calculate the mass and inertia
properties based on the material and geometry of the part.
Mounts define mounting locations between subsystems, and automatically create
communicators which will be discussed in section 4.2.5. No orientation dependency is
required for mounts.
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4.4.3 Attachments
Once the parts in a template have been created, they must be connected together
to properly function. Thus, joints and bushings are required. Multiple options for joint
types are available including, among others:


translational



revolute



cylindrical



spherical



fixed



in-line



in-plane



Hooke



universal

For each joint, one must specify two parts, and varying levels of location and orientation
dependency based on the type of joint being created. Joints may always be active or may
depend on the kinematic mode of the system, a parameter that can be switched on and off
at the subsystem level.
Completely rigid joints are uncommon in most vehicles as they would impart
excessive noise and vibrations into the driver's compartment. Just as in actual vehicles,
bushings at joint locations can be defined in Adams to allow for small deflections and
vibration absorption. Similar to joints, parts, location, and orientation dependencies must
be defined, but unlike joints, geometry and bushing preloads may also be added. The
bushing property file specifies the force-deflection curves for the translational and
rotational stiffness, as well as translational and rotational damping values.
4.4.4 Forces
Templates often also require forces such as springs, dampers, and bumpstops,
which must be created separately from general parts. These items do not have any mass
or inertia properties and are only used to define the forces between existing parts.
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Therefore, if the mass and inertia properties of the real spring and damper are important,
general parts should be created or the mass should be added to other existing parts.
All forces require two interacting parts, orientation reference, and a property file.
Springs also include installed length, spring diameter, and the number of coils. Damper
definitions provide diameter and color inputs for visualization, and bumpstops must
include a clearance. Specifics, such as the connecting parts and orientation dependency
can only be defined at the template level. However, property files may be modified at the
subsystem and full-vehicle model levels.
4.4.5 Communicators
The final step in creating a template is creating and defining communicators. This
is perhaps the least intuitive aspect of Adams/Car templates. Communicators provide the
mounting locations for subsystems upon assembling the full-vehicle model. They can
also transmit forces from one subsystem to another. Input communicators in one
subsystem must have corresponding output communicators in another. Some, such as
mount communicators, are created automatically while most must be created separately.
Information on communicators in an open template file may be accessed via the
Build menu → Communicator → Info... Selecting 'All' in both options of the resulting
window produces a complete list of communicators in the template, as shown in Figure
4-10 for the double wishbone template included in the <acar_shared> database.
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Figure 4-10 - Complete list of communicators in the double wishbone template.

As evident in the list, several different types of communicators are required in a
fully functioning model. The majority of these are locations and mounts used to locate
and tie the individual subsystems together when assembling the full vehicle model.
Mounts also transfer forces from one subsystem to another. For example, forces imparted
on the front subframe are transferred to the chassis via the 'cis_subframe_to_body'
communicator. A few parameter variables must also be defined to allow users to adjust
settings such as camber and toe angles and whether or not the suspension has an active
driveline.
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All communicators must be built at the template level, and cannot be modified in
the subsystems or full-vehicle assembly. One can perform a test between open template
files to ensure that all associated communicators will match upon assembly. The test
launches an information window listing first the matched communicators followed by
any remaining unmatched ones. For example, testing the double wishbone template and
rigid chassis templates shows three matched communicators followed by the remaining
unmatched communicators, as shown in Figure 4-11.

Figure 4-11 - Communicator test results between the double wishbone and rigid
chassis templates.
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Here, the three components which tie into the chassis are the subframe, the upper
strut mount, and the upper control arm. The remaining communicators will match with
other subsystems or the Adams/Car Vehicle Testrig, to be introduced later. This
concludes the section on templates. Fully defined templates are next used to create
subsystems.
4.5 Subsystems
Subsystems are created using completed templates. To create subsystems, the user
must be operating in the Standard Interface in Adams/Car and select File → New →
Subsystem... A popup window will appear, shown in Figure 4-12. New subsystems
require a name, minor role designation, and the associated template file. The minor role
tells Adams where the subsystem will be used. For example, this would define if a
suspension subsystem is for the front or rear of the vehicle, and is especially important if
the same templates will be used to define both subsystems. Once created, the subsystem
will initially retain the geometry and parameters from the template. It will look exactly
the same as the template file it was created upon.

Figure 4-12 - New Subsystem popup window.
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While templates define the basic geometry and connections (of both parts in the
system and connectivity between systems), components are tailored to fit a specific
model at the subsystem level. Users can modify the following parameters:


Hardpoint locations



Part mass, inertia



Subsystem parameters



Spring properties



Damper properties



Bushing properties



Tire properties



Gear properties



Driveline activity

Spring, damper, bushing, and tire properties are all defined using associated
property files. Subsystem parameters vary depending on the type of subsystem. For
example, toe and camber values can be modified for suspension subsystems. Driveline
activity defines whether or not a suspension subsystem has drive capabilities. If it does
not, parts such as the driveshafts in the double wishbone subsystem will be turned off. By
allowing users to modify these parameters at the subsystem level, multiple subsystems
can be created from a single template, thus eliminating the need to create an entirely new
set of templates for each specific vehicle model. As with templates, subsystems are saved
in the default writable database.
4.6 Assemblies
Assemblies must be created using subsystems plus an Adams/Car Testrig in order
to perform simulations. New assemblies are created in the standard interface, and two
types are available: suspension and full-vehicle assemblies. A Testrig is a specialized
subsystem included with Adams/Car which allows the program to communicate with the
vehicle or suspension assembly during simulations. It is how driver (test) inputs are given
to the model.
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4.6.1 Suspension Assemblies
Performing suspension travel simulations without requiring a complete vehicle
model can be accomplished using half-vehicle models called suspension assemblies. To
create a new assembly, select File → New → Suspension Assembly... Then choose the
suspension subsystem, steering (if desired) subsystems, and the MDI Suspension Testrig
to create an assembly such as the mdi_front_vehicle shown in Figure 4-13. This
particular assembly is included in the shared database.

Figure 4-13 - Front vehicle suspension assembly.
The small platforms beneath the tires are part of the MDI Suspension Testrig.
This specialized subsystem allows Adams to communicate with the suspension by
virtually attaching via the wheel centers. During suspension tests, the platforms raise and
lower according to the desired inputs, usually based on suspension travel. The assembly
shown in Figure 4-13 also contains a steering system which can be incorporated into the
suspension tests. Currently, Adams/Car cannot perform quarter-vehicle simulations,
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however, if these are desired, the Adams/View interface could create and simulate such
models.
4.6.2 Full-Vehicle Assemblies
When problems too complex to be solved via a half-vehicle model are presented,
such as determining the overall kinematics of a vehicle, one must create a full-vehicle
model, as shown in Figure 4-14. The procedure for creating a new model is essentially
the same as for the suspension assembly, save for the use of a larger number of
subsystems and the MDI Vehicle Testrig. As the model loads, an information window
appears showing the processes covered by Adams to assemble the vehicle. A list of errors
and warnings will appear at the end of the file including a list of unassigned
communicators. In most cases, these are harmless. For example, the
'tripot_to_differential' communicator is attached to ground in the front suspension
subsystem for the MDI Demo Vehicle. This is allowed since the system has no active
driveline. Thus, the driveshafts do not require any drivetrain input.

Figure 4-14 - MDI Demo Vehicle full-vehicle assembly.
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In the case of full-vehicle models, the Driving Machine provides inputs via the
testrig to the model in much the same way as a test driver would provide inputs to an
actual vehicle. For this reason, Adams/Car models require a greater deal of complexity.
Steering systems must be fully defined so inputs to the steering wheel produce proper
reactions in the vehicle. A complete powertrain is required for acceleration or sustained
forward motion if aerodynamic drag is considered. However, some simulations such as
power-off scenarios can be run without a powertrain where the vehicle has an initial
velocity and then coasts.
All modifications available at the subsystem level are also available in the fullvehicle assembly. This means the user does not have to open all subsystems in a model
separately in order to make changes. With the full-vehicle model open, the aggregate
mass and inertia properties for the entire model can be calculated by selecting Tools →
Aggregate Mass... and selecting 'All.'
4.7 Summary
Adams/Car models are created in three levels: templates, subsystems, and
assemblies. Templates define the basic geometry and connections (of individual parts in
the system and the connectivity between systems). Subsystems refine the geometry and
properties to match specific vehicle models. Models are completed by creating
assemblies which permit the running and analysis of simulations.
The MDI Demo Vehicle included in the <acar_shared> database is a fully
functioning vehicle model which will be used to demonstrate several maneuvers in
conjunction with a vehicle dynamics course. These simulations are presented in the
following sections.
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5 ACCELERATION TESTS
5.1 Introduction
Designing an entire vehicle dynamics course around the Blundell text [15] was
initially considered, but the lack of problems to be worked by students prevented this
concept from being pursued. Thus, using the Blundell text and Adams/Car simulations as
a supplement to an existing course was determined to be the best option.
Here, a basic longitudinal acceleration test is performed using Adams/Car and
results are compared to hand calculations. Using the MDI Demo Vehicle, parameters
such as static axle weights were found using a static equilibrium simulation. Then, two
acceleration tests were run and analyzed using theory presented by Gillespie [13].
The first simulation was performed with no modifications to the vehicle model.
Hand calculations are performed to solve for the front and rear axle loads to compare
with simulation results. A second simulation was run after modifying the vertical location
of the vehicle's center of mass. Comparisons were drawn between the two models, and
again the results are compared to hand calculations.
A step-by-step instructional tutorial for running acceleration tests in Adams/Car is
attached in Appendix A. Specific inputs and instructions for this simulation are included
in an assignment attached in Appendix B.
5.2 Theory
As presented in vehicle dynamics texts [13], forward acceleration is likely the
simplest driving maneuver to simulate. As such, many of the analytical equations, with
reasonable assumptions, can be shown to be highly accurate in real and simulated tests.
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Before examining the physical theory of a vehicle under acceleration, static behavior
must first be established and understood. A free body diagram showing the forces on a
vehicle in motion is shown in Figure 5-1.

Figure 5-1 - Forces acting on a vehicle (image from Gillespie, [13])
Summing the moments about the front and rear tire contact patches yields the
following equations for the front and rear axle loads, respectively [13]:
Wf = (W c cos Θ - Rhx hh - Rhz dh - W/g ax f - DA ha - W h sin Θ)/L

(5-1)

Wr = (W b cos Θ + Rhx hh + Rhz (dh + L) + W/g ax h + DA hA + W h sin Θ)/L (5-2)



W is the weight of the vehicle acting at its CG with a magnitude equal
to the mass times the acceleration of gravity. On a grade it may have
two components, a cosine component which is perpendicular to the
road surface and a sine component parallel to the road.



If the vehicle is accelerating along the road, it is convenient to
represent the effect by an equivalent inertial force known as a
"d'Alembert force" (Jean le Rond d'Alembert, 1717-1783) denoted by
W/g ax acting at the center of gravity opposite to the direction of the
acceleration.



The tires will experience a force normal to the road, denoted by Wf
and Wr, representing the dynamic weights carried on the front and
rear wheels.
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Tractive forces, Fxf and Fxr, or rolling resistance forces, Rxf and Rxr,
may act in the ground plane in the tire contact patch.



DA is the aerodynamic force acting on the body of the vehicle. It may
be represented as acting at a point above the ground indicated by the
height, ha, or by a longitudinal force of the same magnitude in the
ground plane with an associated moment (the aerodynamic pitching
moment) equivalent to DA time hA.



Rhz and Rhx are vertical and longitudinal forces acting at the hitch
point when the vehicle in towing a trailer

-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

Equations in this thesis use the same notations and are of the same form as
Gillespie [13], however are re-numbered to maintain consistency within this thesis.
By assuming the vehicle is stationary on level ground with no outside forces, the
static front and rear axle weights can be calculated as follows [13]:
Wfs = W c/L

(5-3)

Wrs = W b/L

(5-4)

Now, assuming the vehicle accelerates at low speed, where aerodynamic effects
are minimal, the dynamic axle loads are defined as follows [13]:
(5-5)
(5-6)
The second term on the right hand side of the equation is known as the
longitudinal load transfer. For forward acceleration, ax > 0, load is removed from the
front axle and transferred to the rear axle. This load transfer will remain constant so long
as the longitudinal acceleration is constant.
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5.3 Vehicle Parameters
Prior to running the acceleration test, key vehicle parameters had to be found for
use in all hand calculations. These parameters were found using a number of options
available in Adams/Car. Hardpoint locations were used to determine the front and rear
axle locations, and thus the total wheelbase. The aggregate mass function displayed the
mass and CM location for the vehicle. Then, assuming the vehicle is at rest on level
ground, the front and rear axle weights were calculated. Key parameters for calculating
the static axle loads are given in Table 5-1.
Table 5-1 - Locations of key vehicle parameters
Vehicle parameter
Center of mass
Front wheel center
Rear wheel center

x-location
1749.05 mm
267.0 mm
2827.0 mm

z-location
431.68 mm
N/R
N/R

From these values, simple calculations were made to find the parameters for use
in equations (5-3) and (5-4) from the text. These parameters are summarized in Table 5-2.
Table 5-2 - Distances for axle load calculations
Vehicle parameter
L
b
c
h

length
2560 mm
1482.05 mm
1077.95 mm
431.68 mm

Next, a test simulation was run by selecting Simulate → Full-Vehicle Analysis →
Static and Quasi-static Maneuvers → Static Equilibrium... Adding the resulting normal
forces for the front and rear tires provided the axle loads as calculated by Adams. These
values were compared to the hand calculations, as shown in Table 5-3. In both cases,
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there was essentially no error between the two values, indicating the static simulation
produced accurate results.

Table 5-3 - Axle load comparisons
Static Axle Load
Wfs
Wrs

Hand Calculations
6310.45 N
8676.09 N

Adams/Car results
6304.18 N
8677.26 N

% error
0.1%
0.01%

5.4 Baseline Acceleration Test
The baseline acceleration test was run using the unmodified MDI Demo Vehicle.
Acceleration simulations are run by selecting Simulate → Full-Vehicle Analysis →
Straight-Line Events → Acceleration... The inputs for the acceleration test are shown in
Figure 5-2. This simulates a gradual acceleration of 0.25 g from an initial forward
velocity. For a step-by-step tutorial on running acceleration simulations in Adams/Car,
see Appendix A.

Figure 5-2 - Straight-line acceleration test inputs.
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After running the test with the unmodified model, the right-side tire normal forces
were plotted, as shown in Figure 5-3. For the first 0.5 seconds of the simulation, the
vehicle travels at a constant speed and thus the axle loads are equal to those found during
the static test. After 0.5 seconds, the vehicle acceleration very quickly ramps to 0.25 g in
the longitudinal direction. Weight is transferred from the front axle to the rear. A small
oscillation is initially seen as the suspension reacts to the quick change in weight transfer.
The initial spike is quickly damped out and the axle loads remain constant for the
remainder of the run.

Figure 5-3 - Right-side front and rear tire normal forces under constant
acceleration.
Stable values for the right side front and rear wheel loads were found after the
oscillations dissipated. Hand calculations were then performed to find the axle loads and
weight transfer under a constant acceleration of 0.25 g using equations (5-5) and (5-6)
from the text and the parameters found initially. Less than a 2% error was found between
the calculated and simulated longitudinal load transfer, as shown in Table 5-4.
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Table 5-4 - Acceleration test #1 results
Axle Load
Wf
Wr
Long. Load Trans.

Hand Calculations
5678.67 N (2839.34 N/tire)
9307.87 N (4653.93 N/tire)
631.78 N

Adams/Car results
2841 N/tire
4635 N/tire
622.18 N

% error
0.06%
0.41%
1.52%

5.5 CG Location Parameter Study
For the second test, the center of mass for the vehicle chassis was raised 150 mm
from the default value. This changed the vehicle CG height from 431.68 mm to 529.38
mm. The right rear tire normal forces were compared between tests #1 and #2, as shown
in Figure 5-4. As expected, raising the CG height increased the longitudinal load transfer
and thus the rear axle load under acceleration.

Figure 5-4 - Right rear tire normal forces under constant acceleration with stock
CG height, and raised CG height.

Hand calculations were again performed to check the simulated longitudinal load
transfer, as shown in Table 5-5. Simulation results were within 0.5% of the calculations.
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Table 5-5 - Acceleration Test #2 Results.
Axle Load
Wf
Wr
Long. Load Trans.

Hand Calculations
5535.69 N (2767.85 N/tire)
9450.85 N (4725.43 N/tire)
774.76 N

Adams/Car results
2763 N/tire
4713 N/tire
778.18 N

% error
0.18%
0.26%
0.44%

5.6 Discussion
Accomplishing two main objectives, these tests introduced relatively simple
simulations in Adams/Car while also demonstrating the basic physics involved during
longitudinal acceleration. The simulation results were found to be within 1% of nearly all
calculated axle loads and load transfers. Sources for error could be attributed to two main
simplifications. Calculations for load transfers used only the right-side tire forces.
However, the load was not transferred equally to both rear tires since the CG of the
vehicle had a very slight offset in the y-direction. Further, Adams/Car also calculates
aerodynamic forces. However, the relatively slow velocity of this test makes this effect
relatively negligible. A maximum of 65 N drag force was obtained during the simulation,
but this value was small compared to the 14987 N weight of the vehicle. Thus, nearly all
of the load transfer effects were due to the weight of the car, and neglecting aerodynamic
drag was acceptable.
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6 BRAKING TESTS
6.1 Introduction
Building on the concepts introduced during the acceleration test, longitudinal
braking tests investigate the effects of braking bias related specifically to vehicle
stability. A baseline test simulating a gradual braking maneuver was run using the MDI
Demo Vehicle with no modifications, while subsequent tests simulated an abrupt brake
application while modifying the front brake bias. An assignment detailing the test inputs
and instructions for this simulation is attached in Appendix C.
6.2 Theory
Summing the forces and applying Newton's Second Law in the longitudinal
direction on the vehicle using the free body diagram shown in Figure 5-1, the general
equation for braking behavior can be shown to be:
M ax = - W/g Dx = - Fxf - Fxr - DA - W sin Θ

(6-1)

where:
W
g
Dx
Fxf
Fxr
DA
Θ

= Vehicle weight
= Gravitational acceleration
= - ax = Linear deceleration
= Front axle braking force
= Rear axle braking force
= Aerodynamic drag
= Uphill grade

-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]
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Assuming the deceleration maneuver is performed on level ground, the front and rear
axle weights are calculated very similarly to the method outlined during the acceleration
test:
(6-2)
(6-3)
where:
Wfs = Front axle static load
Wrs = Rear axle static load
Wd = (h/L)(W/g)Dx = Dynamic load transfer
-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

As during straight line acceleration, load is transferred only now from the rear axle to the
front.
A few parameters will help to evaluate the braking system performance in the
vehicle. As discussed in Section 3, when a driver applies force to the brake pedal, the
master cylinder pressurizes the brake lines and thus the cylinders in the brake rotors. This
action clamps the brake pads around the brake rotor creating a frictional force which
imparts a brake torque to the wheel. A resulting brake force is created in the tire contact
patch which effectively slows the vehicle.
Brake proportioning, or the balance of braking forces between the front and rear
wheels, can have a significant effect on the braking performance and stability of a
vehicle. This is especially true regarding wheel lockup. For instance, if a driver locks up
the front wheels, he or she will lose the ability to steer the vehicle, which will continue on
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a straight path regardless of steer inputs unless the vehicle is influenced by other factors,
such as a sloped surface.
Rear wheel lockup places a vehicle in a very unstable situation where any yaw
disturbances (which are always acting on a vehicle in motion) will cause the vehicle to
rotate or spin out. As this occurs, the front wheels will yaw with the vehicle and develop
cornering forces which add to the rotation. Only after completely swapping ends will the
vehicle again become stable. In passenger cars with short wheelbases, this instability
would be too powerful for the average driver to correct. Therefore, auto makers almost
always design brake proportioning which favors the front wheels and minimizes the
chances of rear wheel lockup.
A key parameter in determining the true brake proportioning in a vehicle is the
brake gain, G, which is equal to the ratio of brake torque to brake line pressure:
(6-4)
where:
Fb
Tb
r
G
Pa

= Brake force
= Brake torque
= Tire rolling radius
= Brake gain (in-lb/psi)
= Application pressure

-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

Brake bias determines the amount of brake line pressure sent to the front wheels, but does
not indicate the true amount of brake proportioning. For example, a front brake bias of
60% means the front brake lines receive 60% of the total brake line pressure. However,
this does not imply that the front wheels will produce 60% of the brake forces, in general.
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The brake gain must be taken into account to determine the true amount of brake
proportioning front-to-back.
Finally, it should be remembered that since all braking forces are created in the
tire's contact patch, brake performance is critically dependent on the grip between the tire
and the driving surface. Thus, brake bias, brake gain, and tire properties all contribute to
defining the braking performance of a vehicle.
6.3 Basic Braking Test
With units changed from metric to English, the test parameters, shown in Figure
6-1, simulated a gradual application of brakes from an initial velocity of 60 mph. Total
simulation time is 6 seconds, using 600 timesteps. The brakes are applied after 0.5
seconds, and in 1.5 seconds ramp to the 'Final Brake' value. Steering input is set to
provide corrections to keep the vehicle on a straight path. The default 2D road file is
used.

Figure 6-1 - Longitudinal braking test parameters using English units.
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Changing from metric to English units revealed an unexpected behavior relating
to the 'Final Brake' input value. While operating in metric units, this value equated to a
brake force in Newtons. When switching to English units, however, this input did not
produce a matching brake force in lbf. A Final Brake input of '1' returned a brake force of
4.4482 lbf. Initially, it was presumed that Adams attempted to convert the input from
Newtons to lbf, however the conversion appeared to be applied conversely. The correct
conversion is 4.4482 N per 1 lbf. With this conversion accounted for, a Final Brake input
of 1.124 yielded a brake force of 5 lbf, as verified during post-processing.
6.3.1 Simulation Results
Brake torques for all four wheels were plotted, as shown in Figure 6-2. Final
brake torque values were -3425.06 lbf-in in the front and -2047.16 lbf-in in the rear.

Figure 6-2 - Brake torque values under mild braking maneuver.
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After 2.0 seconds, the brake line pressures were 193.54 psi and 129.03 psi for the
front and rear, respectively. Using these values, the braking gain was computed by
rearranging equation (6-4). Brake gain was 17.7 lbf-in/psi in front and 15.9 lbf-in/psi in
the rear.
Normal and longitudinal tire forces were also plotted, as shown in Figure 6-3, to
demonstrate the negative longitudinal forces and forward weight transfer resulting from
the braking maneuver.

Figure 6-3 - Tire forces under mild braking maneuver.
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The initial positive rear tire longitudinal force results from the drivetrain being
used to obtain the initial velocity. Investigating the throttle demand supports this and
shows a gradual decrease from an initially positive value to zero within the first 0.5
seconds. As the brakes are applied, the longitudinal tire forces smoothly transition to a
negative constant value. Weight is transferred from the rear axle to the front axle under
deceleration.
In the chassis acceleration plot, shown in Figure 6-4, an initial small negative
acceleration can be observed as the vehicle experiences drivetrain and aerodynamic drag
forces. A much higher negative acceleration is observed as the brakes are applied from
0.5 to 2.0 seconds. At 2.0 seconds, the largest acceleration is reached, followed by a
slowly decreasing rate of deceleration.

Figure 6-4 - Longitudinal chassis acceleration under mild braking.
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The decrease in deceleration can be attributed to aerodynamic drag, which is a
function of velocity. The brake forces remained constant after 2.0 seconds, but as the
vehicle velocity decreased, so did the aerodynamic drag forces, as shown in Figure 6-5.

Figure 6-5 - Aerodynamic drag forces during mild braking maneuver.
6.3.2 Test Validation
With any computer simulations, test results should be validated to gain confidence
in the accuracy of the model. Complex, nonlinear systems often rely on physical test data
for this, but simple models such as the braking maneuver can be validated using hand
calculations. A summary of the validation data is given in Table 6-1.
Table 6-1 - Model Validation Summary
Parameter
Load transfer

Hand Calculated Value Simulation Value
165.83 lbf
-162.19 (rear)

% error
2.2% (rear)

+158.23 (front)

4.6% (front)

Front brake force/tire

276.44 lbf

270.27 lbf

2.2%

Rear brake force/tire

198.77 lbf

193.08 lbf

2.9%

Chassis accel (no Da)

-0.282 G's

-0.292 G's

3.5%

Chassis accel (w/ Da)

-0.298 G's

-0.292 G's

2.0%
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Axle loads and load transfer are calculated from equations (6-2) and (6-3). The
observed chassis acceleration at 2.0 seconds was -0.292 g. All other parameters are the
same as those given in Section 5.3. The calculated longitudinal load transfer was 165.83
lbf. Compared with the static axle weight values, the rear axle lost 162.19 lbf and the
front gained 158.23 lbf. The load transfer from the rear axle was nearly identical to the
simulated result, however, the load transferred to the front axle was 4.6% less than the
calculated value. This discrepancy is likely due to how Adams accounts for aerodynamic
drag and/or lift. Such effects were neglected in the formulation of equations (6-2) and
(6-3).
Using equation (6-4), the correlation between brake torque and brake force can be
verified. The rolling radius of the left-front tire at 2.0 seconds (after the Final Brake value
was reached) was 12.39 inches and the brake torque was 3425.06 lbf-in. Therefore, the
brake force should be 276.44 lbf. Adams/Car calculated a brake force of 270.27 lbf, a
2.2% smaller value due to longitudinal tire slip calculated in the model.
The rear tire rolling radius was 12.90 inches, and with a brake torque of 2047.16
lbf-in, the calculated rear brake force should be 170.60 lbf. Adams calculated a rear
longitudinal tire force of 193.08 lbf, a value 13% higher than expected. This discrepancy
is attributed to drivetrain drag, as indicated in the total axle torque data, shown in Figure
6-6. This torque adds an additional 516.94 lbf-in of braking torque to each of the rear
wheels, making the total 2564.10 lbf-in per wheel. Thus, the calculated brake force
becomes 198.77 lbf, a value 2.9% higher than the simulation results, which can again be
attributed to tire slip in the model.
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Figure 6-6 - Drivetrain drag applied to rear wheels during mild braking maneuver.

Finally, using equation (6-1), the chassis acceleration was calculated and
compared to the value at 2.0 seconds in the simulation. Using calculated values for the
front and rear brake forces, an uphill grade of zero degrees, and a vehicle weight of
3367.96 lbf, the chassis acceleration assuming zero aerodynamic drag was -0.282 g, a
3.5% error from the Adams calculated acceleration of -0.292 g at 2.0 seconds. Adding in
the aerodynamic drag of 52.16 lbf, the calculated acceleration becomes -0.298 g, a 2%
higher value attributed to longitudinal tire slip causing slightly lower brake forces in the
simulation results.
No error greater than 5% was found in any of the calculations, and most errors
could be attributed to tire slip or aerodynamic effects not included in the calculations.
Therefore, the model accurately predicts the braking behavior.
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6.4 Brake Bias Parameter Study
A brake bias parameter study was performed to determine which case, front or
rear wheel lockup, would be most dangerous for vehicle stability. Simulating a panicked
driver slamming on the brakes to avoid an obstacle on the highway, the study was
performed using the following test input values:
Simulation time length = 5.0 seconds
Number of Steps = 500
Initial velocity = 75 mph
Begin braking after 0.5 seconds
Final brake force = max value = 22.4 lbf* (enter 5.0357) applied in 0.2
seconds
Change the Steering Input to 'locked.' This will not allow for driver
steering inputs so the uncorrected vehicle behavior can be analyzed. (i.e.,
the driver panics and just hangs onto the steering wheel without steering)
A baseline test was run with the brake bias set at the default value of 0.6 (60%
front bias). Following tests incrementally increased the front brake bias by 0.05 until
front wheel lock up was first observed. Then, the front brake bias was incrementally
reduced by 0.05 until rear wheel lock up was first observed. Front wheel lockup was first
achieved at 75% front brake bias, and rear wheel lockup occurred when the front brake
bias was 50%. Longitudinal chassis velocity curves for 75%, 60%, and 50% brake bias
are shown in Figure 6-7.
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Figure 6-7 - Global longitudinal velocity under abrupt braking maneuver for 75%,
60%, and 50% front brake bias.
The 50% brake bias case (rear wheel lockup) yielded the shortest overall stopping
distance, though it did not follow the same general trend as the nearly linear behavior of
the 75% and 60% cases. Investigating the chassis lateral acceleration and velocity, as
well as the chassis yaw revealed the cause of this difference in behavior.
When the rear wheels lockup, the vehicle becomes unstable and rotates to the
right as the back end spins out, as shown in Figure 6-8. The sideways sliding effect
caused the vehicle to slow to a stop more quickly than the other two cases, though at the
expense of a much more dangerous loss of control. During front wheel lockup, the
vehicle retained its straight heading. Thus, relating to vehicle stability and control
purposes, front brake lockup would be favorable to rear wheel lockup despite requiring a
longer distance to stop.
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Figure 6-8 - Lateral chassis acceleration, velocity, and yaw for brake bias of 75/25
and 50/50, front/rear.
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6.5 Discussion
During the mild braking maneuver, the vehicle responded as expected to a light
application of the brakes while at speed. Longitudinal load transfer shifted weight to the
front axle of the car, although aerodynamic effects limited the transfer slightly compared
to calculated values. The existence of drivetrain drag was discovered when solving for
the theoretical brake force in the rear tires. Only longitudinal tire slip, which was not
accounted for in the general equations, was the only likely source of error and was
minimal.
It was determined during the brake bias study that for vehicle stability purposes,
front brake lockup was more desirable since the vehicle retained a straight heading.
During rear brake lockup, the rear of the vehicle spun out creating a dangerous situation
where the vehicle may very well have ended up off the road altogether.
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7 CORNERING TESTS
7.1 Introduction
While longitudinal maneuvers introduce general concepts of vehicle dynamic
behavior, cornering adds an entirely new level of complexity. Steering, suspension, and
tires all contribute to the overall cornering performance of a vehicle. Tire properties now
especially become important as the relationship between lateral tire forces and slip angles
must be understood, including the definition of cornering stiffness, Cα. Additionally,
where longitudinal load transfer was important in simple braking and acceleration tests,
now lateral load transfer becomes important.
The MDI Demo Vehicle doesn't allow for many of the simplifying assumptions
applied in the formulation of the governing equations, thus validation of the model is
extremely difficult. The simulations do, however, successfully demonstrate many of the
concepts presented in the text.
Through two tests, the main concepts concerning corning maneuvers are
introduced and analyzed. First, tire properties are tested using the Tire Testrig to
determine the cornering stiffness for the tires used in the model. Second, a wide turn
(large R) simulation is run using the full vehicle model where the vehicle accelerates until
a maximum lateral acceleration is achieved.
A step-by-step tutorial for setting up and running the tire test in this section is
attached in Appendix D. An assignment designed around these tire and cornering
simulations is attached in Appendix E.
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7.2 Theory
For a vehicle making a turn of radius R, several geometrical parameters become
important, as shown in Figure 7-1. To provide desirable steering response and reduced
tire wear, the inside steer angle, δi, must be slightly larger than the outside steer angle, δo.
However, for large turn radii, where δi ≈ δo, the vehicle may be reduced to a two-wheel or
bicycle approximation. The front and rear tire forces are summed and represented by only
two tires, as shown in Figure 7-2. Using this two-wheel model, the general equations for
cornering are developed. As will be shown, considering the four-wheel model, complete
with a suspension system, quickly complicates the physics involved.

Figure 7-1 - Turning vehicle geometry (image from Gillespie, [13]).

Figure 7-2 - Bicycle model of a cornering vehicle (image from Gillespie, [13]).
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By careful formulation, a simplified governing equation for the bicycle model can
be developed, using English units:
57.3

(7-1)

where:
δ
L
R
V
g
Wf
Wr
Cαf
Cαr

= Steer angle at the front wheels (deg)
= Wheelbase (ft)
= Radius of turn (ft)
= Forward speed (ft/sec)
= Gravitational acceleration constant = 32.2 ft/sec2
= Load on the front axle (lb)
= Load on the rear axle (lb)
= Cornering stiffness of the front tires (lby/deg)
= Cornering stiffness of the rear tires (lby/deg)

-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

The first term on the right hand side is the Ackerman angle. This equation can be
simplified by introducing the understeer gradient, K, so that the equation becomes:
57.3

(7-2)

where:
K = Understeer gradient (deg/g)
ay = Lateral acceleration (g)
-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

The value of the understeer gradient given here only accounts for the effects of
the tire cornering stiffness, however, many other factors contribute to this value. Thus for
a complete vehicle, the understeer gradient is a sum of many parameters, summarized in
Table 7-1.
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Table 7-1 - Understeer Components
Understeer Component

Source
Tire cornering stiffness

∂γ

∂γ

∂φ

∂

∂φ

∂a

Camber thrust
Roll steer
Lateral force compliance steer
Aligning torque

∆

∆

Lateral load transfer
Steering system

-Gillespie, Thomas D., "Fundamentals of Vehicle Dynamics." Society of Automotive
Engineers, Inc: Warrendale, PA. 1992. [13]

Obviously, calculation of the understeer gradient can become incredibly
complicated, highlighting the inherent complexity in vehicle design for cornering
behavior. Experimental methods are the simplest way to determine the true value of K,
which affects the steer angle of a vehicle in a constant radius turn as a function of
velocity squared. Three possible scenarios exist:
1) Neutral Steer: where K = 0
To maintain a constant-radius turn, the steering angle does not depend on the
speed of the vehicle, and is equal to the Ackerman angle. The vehicle is balanced such
that an increase in lateral acceleration at the vehicle's CG causes the front and rear slip
angles to increase at the same rate [13].
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2) Understeer: where K > 0
Since K > 0 in this case, increasing speeds require a larger steering angle to
maintain the same turn radius. If the understeer gradient is constant, it must increase
linearly with the lateral acceleration or with the square of the velocity. Essentially, the
front of the car will "push" away from the direction of the turn. Therefore the driver must
input a greater steer angle to develop the lateral forces necessary to maintain the same
turn radius [13]. This case is often considered to be the safest for typical drivers, and
most passenger vehicles exhibit understeer behavior.
3) Oversteer: K < 0
Here the steer angle must decrease with increasing lateral acceleration or with the
square of the speed to maintain a constant radius turn. From the driver's perspective, the
rear axle tries to "step out" away from the radius of the turn and turns the entire vehicle
further into the turn [13]. Thus the steer angle at the front tires must be decreased to
maintain the same turn radius. Race car drivers often refer to "snap oversteer" when
pushing rear-wheel-drive vehicles to their limits on a race course. As the driver applies
power to accelerate the car through the middle of a corner, the rear tires may suddenly
lose grip with the track causing the rear of the vehicle to slide away from the corner. The
sport of drifting demonstrates the extreme of this effect. High levels of driver skill are
required to handle oversteer, and manufacturers avoid this behavior in the design of
passenger vehicles.
Graphically, the differences between the three conditions become more apparent,
as shown in Figure 7-3, and two more parameters are defined. Characteristic speed is
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defined as the velocity at which the steer angle required for an oversteer vehicle is twice
the Ackerman angle to maintain the same turn radius [13]:
57.3

/

(7-3)

Critical speed is the velocity at which a steer angle of zero is required to maintain the
same turn radius in an oversteer vehicle [13]:
57.3

/

(7-4)

At speeds beyond this value, the vehicle becomes unstable and a negative steer angle
with respect to the turn is required.

Figure 7-3 - Steer angle as a function of forward speed for neutral, over, and
understeer vehicles (image from Gillespie, [13]).

Lateral acceleration gain is the ratio of lateral acceleration to steer angle, and is
defined as [13]:
.

(deg/s)
.

(7-5)
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For neutral steer (K=0), the lateral acceleration gain depends only on the term in
the numerator, and is a function of the velocity squared [13]. Understeer vehicles will
exhibit lateral acceleration gain below the neutral steer curve, and oversteer vehicles will
remain above the neutral steer curve.
Yaw velocity gain is the ratio of the yaw velocity (yaw rate, r) to the steer angle.
The yaw velocity is the rate or rotation in the vehicle's heading [13]:
r = 57.3 V/R

(deg/s)

(7-6)

where V has units ft/s and R is measured in ft. The yaw velocity gain is defined as [13]:
/

(7-7)

.

Yaw velocity gain for the oversteer, neutral steer, and understeer cases is shown
in Figure 7-4. For neutral steer, the yaw velocity gain is linear with speed, and the only
vehicle parameter needed is the vehicle wheelbase. Oversteer vehicles increase yaw
velocity faster than during neutral steer, approaching infinity at the critical speed. For
understeer, the yaw velocity gain remains below the neutral steer curve. It approaches a
maximum value at the characteristic speed before decreasing afterwards.

Figure 7-4 - Yaw velocity gain vs. vehicle speed (image from Gillespie, [13]).
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Finally, vehicle side slip is the angle between the vehicle heading and the
longitudinal axis of the vehicle. In low-speed turns, the side slip angle is positive due to
the slip in the front tires, as shown in Figure 7-5. As velocity increases, the rear wheels
must begin to slip in order to supply the necessary lateral forces to maintain the turn, and
the vehicle slip angle becomes negative, as shown in Figure 7-6.

Figure 7-5 - Low speed vehicle side slip (image from Gillespie, [13]).

Figure 7-6 - High speed vehicle side slip (image from Gillespie, [13]).

7.3 Tire Tests
Adams/Car tire models were determined to be excessively complicated to justify
an in-depth analysis. For example, a typical tire model available in the <acar_shared>
database contains over 100 different coefficients to define the geometry and dynamic
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behavior of the tire. Further, nine different types of tire models are compatible with
Adams/Car [18]. Each type of tire model is optimized for different scenarios. Some are
tailored for level-ground handing simulations while others are used for traversing
obstacles or ride analyses. Tire modeling theory in general is a constantly developing
field putting it beyond the scope of this thesis.
Thus, for all simulations, the tire properties available in the shared database are
used. To better understand the behavior of these tire models, the Tire Testrig provides a
convenient way to develop the lateral force vs. slip angle plots required to find the
cornering coefficients for cornering test calculations.
Developed to simulate a physical test stand used by tire companies, the Tire
Testrig can be accessed through the Adams/Car standard interface by selecting Simulate
→ Component Analysis → Tire Testrig... The front and rear tires of the MDI Demo
Vehicle are analyzed here. See the Tire Testrig tutorial attached in Appendix D to show
how to set up the analysis for this test.
First, the lateral force vs. slip angle was plotted to determine the cornering
stiffness values for each tire, as shown in Figure 7-7. The second set of curves at negative
slip angles results from the direction from which the testrig turns the tire. Using slip angle
values from -1.88 to 1.88 degrees, a linear approximation was made to find the front and
rear corning stiffness values (after converting for units):


Cαf = 261.4 lby/deg



Cαr = 359.38 lby/deg
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Figure 7-7 - Lateral force vs. slip angle for MDI Demo Vehicle tires.
Using the cornering stiffness values, the tire component of the understeer gradient
is calculated as -0.0032 deg/g indicating the tires are well balanced relating to the
understeer tendencies of the vehicle. However, as will be shown in a constant radius
cornering maneuver, the MDI Demo Vehicle exhibits understeer behavior. Thus, the
effects of suspension and steering components obviously play an important role in the
vehicle's handling characteristics.
7.4 Constant Radius Cornering
A long, sweeping turn is simulated by selecting Simulate → Full-Vehicle
Analysis → Static and Quasi-Static Maneuvers → Constant Radius Cornering... The
following inputs were used:






Number of Steps: 100
Simulation Mode: interactive (default)
Road Data File: (default)
Turn Radius: 100 m
Final Lateral Accel (g): 0.8
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Note that the inputs (like the tire test inputs) are specified using metric units. It
was determined that cornering simulations run using the MDI Demo Vehicle while
operating in English did not compute the inputs correctly. So, this simulation was run in
metric units, and the results were converted during post-processing to English units for
use with the equations by Gillespie [13].
To determine the understeer or oversteer behavior of the vehicle, the steer angle
vs. longitudinal velocity was plotted, as shown in Figure 7-8. Using either a separate
post-processor or a spreadsheet, the data had to be converted from metric to English
units. Also, Adams/Car produces the steer angle at the steering wheel (equivalent of what
a driver would have to input during the maneuver). Therefore, the data was scaled so the
initial steer angle at zero velocity equaled the Ackerman angle, 1.467º, and although the
vehicle performs a right hand turn, the steer angle is shown as positive.

Figure 7-8 - Tire steer angle vs. velocity.
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Clearly, the vehicle exhibits understeer behavior as the steering angle increases
with velocity in the constant-radius turn. The characteristic velocity is 81.1 ft/s. Thus, the
understeer gradient is found to be 2.36 deg/g. Theoretical values for the steer angle are
also shown in Figure 7-8, and assume the value of K remains constant. This assumption
appears to be a decent approximation, but obviously the value of K does not remain
exactly constant. Several of the factors contributing to K are dependent on dynamic
values. For example, lateral load transfer, shown in the normal tire forces in Figure 7-9,
affects the understeer gradient directly as well as altering the cornering stiffness values
for the tires, as shown in Figure 7-10.

Figure 7-9 - Normal tire forces during constant radius cornering.
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Figure 7-10 - Lateral tire forces vs. slip angle during constant radius cornering.
At 0.8 G's, the load transfer was 753 lb in the front and 812 lb in the rear totaling
of 46.5% of the vehicle's curb weight. Additionally, the lateral load transfer is linear with
respect to lateral acceleration. This load transfer visibly affects the cornering stiffness of
the tires compared to the static loading case simulated with the Tire Testrig. The load
transfer increases the cornering stiffness for the left side tires enough for the relationship
between lateral force and slip angle to remain relatively linear even at slip angles above
2.5 degrees. Note that this relationship remained linear only for slip angles within 1.5
degrees during the static load test previously.
An inverse effect is shown in the data for the right side tires. As the load
decreases, the lateral forces exhibit nonlinear behavior and reach a much lower maximum
value than shown during the tire test. The cornering stiffness for the right front tire can
only be assumed to be linear for about 0.5 degrees before quickly trailing off. Solver
initialization causes the strange behavior in the rear right tire lateral forces at less than 0.8
degree slip.
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Due to the load transfer during the right hand turn, the left side tires generated the
majority of the lateral forces. The front right tire had the smallest load of all four tires
during the maneuver and thus generated the least lateral forces.
Lateral acceleration gain and yaw velocity gain also both show understeer
behavior, as shown in Figure 7-11. Data for a neutral steer vehicle are also shown, and in
the case of lateral acceleration gain, the Adams simulation results remain below the
neutral steer line. For yaw velocity gain, the Adams simulation also deviates below the
neutral steer case, again indicating understeer.

Figure 7-11 - Lateral acceleration and yaw velocity gain for the Adams/Car
simulation.
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Beginning the turn from a stop, the vehicle side slip angle is negative at first until
the velocity increases to a point where the rear tires must slip enough to supply the
necessary lateral forces to maintain the turn, as shown in Figure 7-12. As the rear tire slip
increases, the vehicle side slip increases and eventually becomes positive. This is inverted
from the Adams convention to follow the SAE convention where all clockwise angles
viewed from above are positive. At 53 ft/s, the side slip angle is zero.

Figure 7-12 - Vehicle Side Slip Angle vs. velocity for constant radius cornering.

7.5 Discussion
These simulations successfully provided meaningful examples of the theory
presented by Gillespie [13]. The constant radius cornering maneuver displayed the
understeer behavior of the MDI Demo Vehicle. Over 45% of the vehicle's curb weight
was transferred from the right to the left side tires during the turn at 0.8 g lateral
acceleration. This load transfer likely contributed the most to the positive understeer
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coefficient, calculated as K = 2.36 deg/g at the characteristic speed of 81.1 ft/s. The
cornering stiffness for the left side tires remained fairly linear throughout the maneuver,
while the smaller load on the right side caused the right tire cornering stiffness to be
highly nonlinear and much smaller than those for the left side. All four tires deviated
significantly from the cornering stiffness values found during the tire tests, providing a
direct example of how tire load affects cornering stiffness in tires.
Lateral acceleration gain and yaw velocity gain data both confirmed the
understeer behavior first observed in the steer angle vs. velocity results. If desired to add
more complexity to this simulation, more hand calculations to determine other
components of the understeer gradient could be added, but were omitted here; since the
objective was to present an introduction to the fundamentals of a cornering maneuver.
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PART II: 2270P MODEL AND V-DITCH TRAJECTORIES
8 2270P Model
8.1 Introduction
Federal standards for crash testing are presented in the American Association of
State Highway and Transportation Officials (AASHTO) Manual for Assessing Safety
Hardware (MASH) which includes several standard vehicles [20]. The National Crash
Analysis Center (NCAC) at The George Washington University's Virginia campus
produces complete finite element (FE) models for crash test simulations for many of the
MASH standard vehicles. One of the most commonly used vehicles for testing highway
guardrail and barrier systems is the 2270P pickup model, shown in Figure 8.1.
Uncertainty in the accuracy of the suspension behavior in the FE model provided the
motivation to create a 2270P model in Adams/Car. Ultimately, this model will allow for
future vehicle dynamics simulations relating to crash testing and highway barrier system
design.
NCAC developed their pickup model from a 2007 Chevy Silverado and adjusted
the vehicle mass to match the 2270 kg MASH standard. This model is currently being
used in finite element analysis (FEA) simulations at the Midwest Roadside Safety
Facility (MwRSF) at the University of Nebraska-Lincoln, including a study on vehicle
trajectories into and out of V-ditch medians [3]. The NCAC model served as the basis for
the geometry and mass properties in the multibody dynamics 2270P model created in
Adams/Car, also shown in Figure 8-1. Throughout the development of the 2270P model,

91
attempts were made to utilize the existing subsystems and templates in the Adams
software package as much as possible.

Figure 8-1 - NCAC FE model [16] (left) and Adams/Car multibody dynamics model
(right) of a 2007 Chevy Silverado pickup.

8.3 Chassis/Body
An existing chassis template in the <acar_shared> database was utilized for the
2270P model. Initially, the template included basic hardpoint locations and
communicators, but was devoid of any graphics. A graphics file was created from the
body panels in the NCAC model [16] and imported to the Adams/Car chassis template,
providing the vehicle geometry shown in Figure 8-1. Graphics in Adams are for visual
purposes only when computing rigid body dynamics as the solver only requires the
connections and mass properties at the CG for each part to solve for the dynamics in the
system.
Communicators specific to the Hotchkiss rear suspension had to be added to the
template as well as parts used as markers for accelerometers and string potentiometers.
Chassis subsystem hardpoints are shown in Figures 8-2 and 8-3 and their locations are
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given in Table 8-1. All node numbers reference the NCAC Chevy Silverado pickup
model.

Figure 8-2 - 2270P body front hardpoint locations.

Figure 8-3 - 2270P body rear hardpoint locations.
Table 8-1 - 2270P body hardpoint locations
HP Name
hpl_front_strut_accelerometer
hpl_front_strut_stringpot

x (mm)
335.04
607.73

y (mm)
-477.72
-508.95

z (mm)
635.33
731.91

hpl_front_wheel_center
hpl_rear_accelerometer
hpl_rear_frame_stringpot

525.84
4154.56
4157.28

-882.86
-465.04
-542.2

396.44
742.49
744.24

hpl_rear_wheel_center
hps_bumper_marker
hps_path_reference

4170.68
-172.31
0

-848.69
-951.94
0

396.44
660.52
0

Notes
NCAC test report [8]
NCAC test report [8]
(see notes in suspension
tables)
NCAC test report [8]
NCAC test report [8]
(see notes in suspension
tables)
MwRSF report [3]
Adams/Car default
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8.4 Front suspension
The front suspension of the 2270P is of a double wishbone (double A-arm)
design, as shown in Figure 8-4, allowing the use of the double wishbone template in the
<acar_shared> database. Spring and damper rates were modified to match the parameters
of the NCAC model. The damper rates were scaled from the NCAC curves to improve
suspension behavior in a speedbump test.

Figure 8-4 - NCAC FE front suspension (left) and Adams/Car front suspension
(right).
Dummy parts for accelerometers and string potentiometers were added to the
front suspension model for obtaining data for validation against full-scale vehicle tests
[8]. These parts were located in accordance with the physical test procedures to provide
direct comparison of the suspension behavior. Front suspension hardpoints are shown in
Figure 8-5 and their locations are summarized in Table 8-2.
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Figure 8-5 - 2270P front suspension hardpoint locations.

Table 8-2 - 2270P Front Suspension Hardpoint Locations
HP Name
hpl_drive_shaft_inr
hpl_front_lca_accel
hpl_front_lca_stringpot
hpl_lca_front
hpl_lca_outer
hpl_lca_rear
hpl_lwr_strut_mount
hpl_subframe_front
hpl_subframe_rear
hpl_tierod_inner
hpl_tierod_outer
hpl_top_mount
hpl_uca_front
hpl_uca_outer
hpl_uca_rear

x (mm)

y (mm)

z (mm)

326.81
598.12
263.42
508.25
693.57
478.15
262.05
706.25
348.14
372.72
467.65
331.14
536.23
612.95

-501.37
-558.52
-339.35
-792.4
-341.14
-606.51
-400.53
-400.54
-387.29
-783.23
-492.73
-481.62
-733.38
-483.96

297.84
325.67
312.94
292.37
323.25
330.98
465.19
440.76
404.83
407.68
737.81
565.93
546.26
532.5

Nodes used* Notes
N/A
2857326
2859019
2530549, 2530547
2530561
2530545, 2530543
2538085, 2538076
2332540 approx loc
2336832 approx loc
2689988
2689989
2534490
2530551, 2530553
2530559
2530555, 2530557

hpl_wheel_center

525.84

-882.86

396.44

2530565, 2530563 brake rotor face

y-dim from
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8.5 Rear Suspension
No templates for a Hotchkiss, leaf suspension system are currently available in
the <acar_shared> database. A publicly-released 3-link model was obtained, shown in
Figure 8-6, and modified to fit the 2270P model. The system is based on the SAE ThreeLink Leaf-Spring model, presented in a 2005 paper by P. Jayakumar, et. al [18].
Dimensions of the three-link mechanism were computed using SAE guidelines from key
dimensions shown in Figure 8-7.

Figure 8-6 - Three-link Hotchkiss rear suspension model.

Figure 8-7 - Geometry for SAE 3-link leaf spring approximation [18].
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Key dimensions are:


L = Total spring length as measured along the main leaf



m = Front inactive length



n = Rear inactive length



a = Fixed cantilever length, called front length (includes the inactive length, m)



b = Shackled cantilever length, called rear length (includes the inactive length, n)

From these dimensions, the geometry of the three-link model, shown in Figure 8-8, was
calculated using [18]:


Ra = 0.75(a - m)



Rb = 0.75(b - n)



Rc = L - (Ra + Rb)



d = (a - Ra)

Figure 8-8 - Rear leaf spring link geometry.
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Jayakumar also provides equations for the torsional springs at each end of the
center link which suspend the system [18]. However, while determining the geometry
from the NCAC model was relatively simple, determining an effective spring rate and
thus the equations for the torsional springs was found to be prohibitive to pursue in the
timeframe of this research. The 3-link model uses a torsional preload on the bushing
which joins the front and center links, and a parameter study was performed to find the
value that worked best. Engineering judgment and physical test video when available
were used to decide which value provided the correct ride height and suspension
flexibility in simulations. Hardpoints in the rear suspension are shown in Figure 8-9 and
their locations are given in Table 8-3.

Figure 8-9 - 2270P rear suspension hardpoint locations.
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Table 8-3 - 2270P Rear Suspension Hardpoint Locations
HP Name
hpl_accelerometer_location
hpl_axle_tube_outer
hpl_front_leaf_eye
hpl_front_torsional_joint
hpl_jounce_at_axle
hpl_jounce_at_frame
hpl_leaf_spring_to_shackle
hpl_pseudo_steer_axis
hpl_rear_torsional_joint
hpl_second_stage_on_axle
hpl_second_stage_on_frame
hpl_shackle_to_frame
hpl_shock_lower
hpl_shock_upper
hpl_stringpot_loc
hpl_wheel_center
hpr_shock_lower
hpr_shock_upper

x (mm)
4170.68
4170.68
3351.73
3923.21
4172.1
4162.57
4936.61
4330
4396.71
4172.1
4169.08
4950.28
4274.77
4443.21
4170.68
4170.68
4107.72
3862.26

y (mm)
-418.69
-773.36
-619.62
-622.04
-501.17
-501.67
-627.13
-860
-624.91
-623.48
-623.48
-626.77
-489.38
-374.86
-538.69
-848.69
488.51
373.97

z (mm)
441.44
396.44
506.09
490.77
445.06
631.17
729.36
440
557.76
378
437
617.58
283.67
800.13
441.44
396.44
258.04
785.73

Nodes used* Notes
2689835, 2927740
2530045, 2530047
[18]
2939834
2349303
2530037, 2530039
[18]

2530041, 2530043
2530567
2530570
2689835, 2689834
2530568
2530569

*Node numbers are from NCAC model [16]
The rear suspension provided the most difficulty and also presents an area for
further model improvement. As will be discussed later, a speedbump simulation showed
that the rear axle likely does not have as much flexibility as it should during opposite
wheel travel.
8.6 Steering
A steering rack and tie rods are included in the FE model, so the existing rackand-pinion steering template in the <acar_shared> database was used with only minor
modifications. The rack and tie rods were located using the FE model, and the steering
column and wheel were placed in a reasonable location in the cab. Since full-scale crash
tests do not include steering inputs, and are done with the vehicle traveling initially in a
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straight line, the steering system was of minor importance for the simulations covered in
the following sections. However, its inclusion, along with a complete braking system,
provides opportunities to investigate driver inputs in future simulations. Harpoint
locations are shown in Figure 8-10 with locations given in Table 8-4.

Figure 8-10 - 2270P steering subsystem hardpoint locations.

Table 8-4 - 2270P Steering Subsystem Hardpoint Locations
HP Name
hpl_rack_house_mount
hpl_tierod_inner
hps_intermediate_shaft_forward
hps_intermediate_shaft_rearward
hps_pinion_pivot
hps_steering_wheel_center

x (mm)
348.14
348.14
533.25
809.09
348.14

y (mm)
-337.29
-387.29
-342.61
-578.92
-139.29

z (mm)
404.83
404.83
729.06
881.1
404.83

1500

-578.92

1300

*Node numbers are from NCAC FE model [16]

Nodes used* Notes
2689988
2415104
2038346
2483303,
2483176
approx.
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8.7 Brakes
Although braking inputs were not considered in the simulations, a four-wheel disk
brake system available in the <acar_shared> database was included in the 2270P model.
The brake system does not add any mass to the vehicle, so the brake rotor masses were
added to the front wheels, and the mass of the brake drums was added to the rear axle. As
with the steering system, braking inputs could be used in parameter studies in the future.
8.8 Tires
A tire model from the <acar_shared> database was modified to match the
dimensions of the P245/70R17 tires on the test vehicle used by NCAC. The model is
based on methods developed by Pacejka [19]. While it is not ideal for crossing obstacles
or on road profiles with wavelengths shorter than the tire radius, the more robust and
deformable 'FTire' model was not available for this research. Thus, tire modeling presents
one of the largest areas for future research relating to the 2270P model.
8.9 Antiroll Bar
A simple antiroll bar also available in the <acar_shared> database was used to
determine its effects on the model's performance. Both the actual Silverado and the
NCAC model have an antiroll bar in the front suspension. As will be shown in the
following simulations, results were mixed as to its benefits when used in the model.
8.10 Drivetrain
Due to complexities resulting from the straight drive axle in the rear, a drivetrain
could not be successfully incorporated into the model at this time. The drivetrain template
in the <acar_shared> database was designed for use in independent suspension systems
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where the differential parts attach directly to the vehicle chassis, not to a deflecting
straight rear axle. Therefore, the simulations were run in 'power-off' mode, and no
drivetrain drag was accounted for. While this did affect the results in a low-speed test, it
would likely not be a large factor in tests at highway speeds. Associated drivetrain
masses were added to the chassis subsystem.
8.11 2270P Modeling Guidelines
Simulations using the 2270P model demonstrated a need to compensate for
inaccuracies in the model in predicting tire deformations. Further, events such as bumper
or body impact with the ground may be important and Adams/Car does not account for
contact with anything other than the tires. Both tire and bumper deformations absorb
energy, thus the following set of guidelines was developed for scaling the damper rates to
compensate for these effects.
Step 1: Run Baseline Model
For a given test scenario, a baseline simulation should be run. Here, "baseline"
refers to running a test with the 2270P model using the default damper rates (no scaling).
Step 2: Analyze Baseline Results
Post-process the baseline simulation results to determine the model behavior.
Comparisons should be made with physical test data, if available. This was done in the
speed bump tests in Section 9. If physical tests have not been performed, results from
previous simulations may be used. In the case of the V-ditch simulations, comparisons
are made to previous LS-Dyna results [3]. Several factors should be considered during
this step, including:
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a) Does the test scenario involve tire deformations?
b) How severe are those deformations?
c) Does any portion of the vehicle besides the tires strike the ground?
d) Are compliant soils important?
Each of these factors may be compensated for by altering damping rates but will
vary considerably depending on the scenario.
Step 3: Scale Damper Property Files
Based on the answers to the questions from Step 2, the damper property files
should be scaled to compensate. For traversing obstacles involving relatively small tire
deformations, scaling the dampers by two produces good results, as will be shown in
Section 9. However, in the case of higher impact forces leading to large tire deformations
and bumper contact with the ground, the damper rates should be scaled by a factor of 10
or more. The objective of scaling damper properties is to allow the model to dissipate
impact energy.
Step 4: Analyze Improved Results
The results from running the model with increased damping should again be
compared to the available validation data. If the new results are not acceptable, note how
much the changes improved or worsened the results to help with choosing better damping
scale factors.
Step 5: Repeat Steps 3 and 4 Until Desired Results are Obtained
An iterative process is often required to find the best damping rates for a given
test scenario. The final damping value is difficult to predict beforehand, and each test will
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require a unique scale factor. Fortunately, most Adams/Car simulations can be run in a
matter of minutes, thus speeding up this process.
8.12 Summary
This MBS model of the MASH 2270P model represents a starting point for future
model improvement and development, where none previously existed. After assembling
the complete vehicle, the total vehicle mass was 2289.9 kg and the CG was located at
(2059.2, 9.9, 734.5), all locations in mm. The NCAC model had a total mass of 2270.8 kg
with the CG located at (2059.9, 10.5, 735.2), again with all locations in mm. Mass and
inertia properties for major components in the NCAC FE model are given in Table 8-5.
Most of the subsystems are based on available templates, and geometry and mass
properties were carried over from the NCAC model. Nearly massless parts were added to
the suspension and chassis to represent accelerometers and string potentiometers used in
physical tests. The rear suspension proved to be the most challenging aspect of the model
development. Both it and the tire models should be improved upon for future simulations.
The addition of a functioning drivetrain could also be considered in the future.
As a multibody systems software, Adams is unable to accurately model vehicle
component deformations. While a deformable tire model would improve results for low
impact cases, the program will never be able to accurately model chassis or body
deformation. It should only be used for investigating suspension dynamics. However,
scaling damper rates may help to compensate for small component deformations, and a
set of guidelines was developed detailing this process. Final damper rates will then
account for (if applicable): normal damper functions, tire deformations, body contact
with the ground, and deformable soils.

Table 8-5 - 2270P Major Part Mass and Inertia Properties*
Part name

Mass
(kg)

Ixx
(kg/mm2)

Iyy
(kg/mm2)

Izz
(kg/mm2)

Ixy
(kg/mm2)

Iyz
(kg/mm2)

Ixz
(kg/mm2)

CG location (x,y,z)
(mm, mm, mm)

body & chassis & drivetrain
front lwr control arm
front spindle
front subframe
front sway bar
front uppr control arm
front wheel + brake rotor
leaf spring
leaf shackle
rear axle + brake drum
rear wheel
steering rack

1789.90
10.50
11.70
22.06
6.14
2.54
56.10
24.81
0.65
158.49
44.20
12.40

7.24E+08
1.58E+05
9.08E+04
1.65E+06
8.70E+05
2.09E+04
2.58E+06
1.30E+05
2.24E+03
5.67E+07
2.54E+06
6.08E+05

4.17E+09
1.45E+05
1.06E+05
1.13E+06
6.29E+04
3.02E+04
4.47E+06
4.70E+06
7.02E+02
4.06E+06
8.46E+06
2.20E+04

4.45E+09
2.98E+05
6.10E+04
2.55E+06
9.23E+05
4.92E+04
3.68E+06
4.59E+06
1.70E+03
5.96E+07
7.87E+06
5.99E+05

1.17E+07
-5.69E+01
-2.17E+01
-2.69E+04
2.21E+03
5.02E+03
-8.43E+05
2.32E+04
-1.23E-01
7.22E+04
1.96E+06
-1.19E+04

2.92E+06
-4.27E+03
-7.66E+03
8.33E+03
1.85E+03
1.93E+03
-7.88E+04
3.48E+03
-1.31E+00
1.89E+04
-9.27E+04
-7.61E+03

-7.58E+07
-5.04E+03
-7.02E+03
7.51E+04
1.58E+04
2.48E+03
-1.07E+05
-6.23E+05
1.24E+02
1.39E+05
2.57E+05
-2.44E+02

1899.95, 13.1465, 820.592
499.512, -578.486, 303.155
519.398, -826.921, 390.109
427.09, -6.66565, 364.195
804.001, 11.7575, 357.968
501.037, -600.268, 559.854
678.628, -770.513, 410.53
4152.75, -623.516, 531.065
4944.22, -627.115, 700.387
4054.96, 1.54029, 398.643
4171.92, -859.779, 396.26
357.634, 24.2844, 408.971

full vehicle

2269.67

1.05E+09

6.03E+09

6.49E+09

1.51E+07

1.01E+06

3.38E+07

2060.43, 10.5118, 735.278

*Properties taken from NCAC FE model [16]
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9 2270P MODEL VALIDATION: SPEED BUMP TEST
9.1 Introduction
In July, 2009, NCAC conducted a full-scale test on a 2007 Chevy Silverado
suspension system using a speed bump at the Federal Outdoor Impact Laboratory (FOIL)
[8]. The data from this test was used to validate the 2270P model created in Adams/Car.
9.2 Full-scale Test Set Up
9.2.1 Test Vehicle
A 2007 Chevy Silverado 1500 2WD 4 door crew cab short box pickup was used
in the speed bump test, as shown in Figure 9-1. It was equipped with a 4.8 liter engine
and 4 speed automatic transmission with P245/70R17 tires. Vehicle curb weight was
2298 kg and increased to 2325 kg with all data acquisition, emergency braking systems,
and battery modules during the test [8].

Figure 9-1 - 2007 Chevy Silverado 1500 (NCAC [8]).
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9.2.2 Test Instrumentation
Accelerometers and string pot potentiometers were placed at several locations on
the vehicle chassis and suspension components to monitor the suspension behavior
during the test. Locations for these sensors are shown in Figure 9-2.

Figure 9-2 - Sensor locations during full-scale speed bump test (NCAC, [8]).
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Brackets were welded to the lower control arms to properly position the string pot
potentiometers to measure suspension deflection. A similar set up was used in the rear
suspension as well.
Several high speed cameras filming at 500 frames per second recorded the event.
Real-time videos were also taken using other cameras.
9.2.3 Test Description
A commercially available speed bump was modified by adding a 2 x 12 wood
plank beneath to provide a greater impulse to the suspension system, as shown in Figure
9-3, with pieces added to smooth the transition, as shown in Figure 9-4. The test was
performed by impacting the speed bump with the right side tire only at a speed of 16
km/hr.

Figure 9-3 - Commercial (left) and modified (right) speed bumps (NCAC, [8]).

Figure 9-4 - Modified speed bump with smoothed transitions on front side (NCAC,
[8]).
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9.3 Adams/Car Simulation Set Up
The 2270P model was used in a 'Power-off Straight Line' test using a 3D road file
with a grid obstacle to match the dimensions of the modified speed bump, as shown in
Figure 9-5. Using the Road Builder (Simulate → Full-Vehicle Analysis → Road
Builder...), obstacles can be added to 3D road files. For this simulation, a grid obstacle
was used enabling the direct input of the speed bump geometry. Test inputs were as
shown in Figure 9-6.

Figure 9-5 - Adams/Car speed bump simulation set up.

Figure 9-6 - Adams/Car speed bump simulation inputs.
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Simulations were initially run with an output time step size of 1 ms, but did not
capture enough data points to accurately show the true acceleration and deflection
behavior of the suspension. Thus, the time step was reduced to 0.1 ms. Total computation
time averaged less than 10 minutes for a 3.0-second simulation, even when running the
shorter time step.
Four simulations were run. The first was used as a control and ran with the spring
and damper rates transferred from the FE model. The first simulation did not include an
antiroll bar. Three subsequent modifications were then tested. In the first, an antiroll bar
was added to the model. The second modification removed the ARB again and doubled
the damper rates. The third modification combined the ARB with the increased damper
rates.
9.4 Results: Baseline Model
Sequential photographs from the physical test and simulation are shown in
Figures 9-7 and 9-8. While the initial velocity was the same in both the physical and
simulated tests, drivetrain drag slowed the vehicle during the physical test while the
velocity remained nearly constant throughout the simulation.
Suspension and chassis component acceleration and deflection data are shown in
Figures 9-9 through 9-12. While the simulation behaved similarly to the physical test in
most cases, obvious errors in the data were also observed. Most significantly, the
maximum deflection of the right front suspension was 22 mm in the physical test, while
the simulation predicted over 45 mm of deflection. Further, the simulation displayed a
much more pronounced oscillatory response after the wheel unloaded from the speed
bump.
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0.00 s

(start of test)

0.00 s

0.22 s

(front tire impacts)

0.23 s

0.44 s

(front tire unloads)

0.39 s

0.66 s

0.61 s

Figure 9-7 - Sequential photographs from speed bump test, perpendicular to
passenger side. Physical test photos are from NCAC [8].
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0.88 s

0.78 s

1.10 s

0.94 s

1.32 s

(rear tire impacts)

1.08 s

1.54 s

(rear tire unloads)

1.23 s

Figure 9-8 - Continued sequential photographs from speed bump test,
perpendicular to passenger side. Physical test photos are from NCAC [8].
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Figure 9-9 - Front suspension accelerations. Physical data from NCAC [8].
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Figure 9-10 - Rear suspension accelerations. Physical test data from NCAC [8].
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Figure 9-11 - Front suspension deflections. Physical test data from NCAC, [8].

Figure 9-12 - Rear suspension deflections. Physical test data from NCAC [8].
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In general, using the spring and damper rates specified in the FE model, the
simulation exhibited a much larger suspension response when hitting the speed bump. As
the right-front wheel unloads off the speed bump at around 0.4 seconds, the tire bounces
on the ground leading to the sinusoidal behavior in the deflection curve. Body roll was
created which caused the small initial compression in the left front suspension in the
physical test. The Adams/Car simulation, however, did not record this behavior. A slight
decompression as the body rolled back to the right after unloading was observed in both
data sets. Unlike the physical test, the simulation predicted the body would roll back to
the left indicating an oscillation in body roll. In general, though, both data sets showed
the independent front suspension transferred relatively little reaction to the left side.
The rear suspension caused a much more pronounced deflection in the left side
suspension since the two sides are directly tied together via the solid axle. In the physical
test, the left side did not experience any compression when the right tire impacted the
speed bump. The simulation, however, predicted almost the exact same amount of
compression for both the right and left sides. The entire axle compressed when the right
rear tire impacted the speed bump causing the left rear tire to momentarily leave the
ground, indicating a lack of flexibility in the suspension during opposite wheel travel.
The rear axle also experienced much higher accelerations than were recorded in
the physical test with peaks of about +/- 6 g on both sides. Large oscillations in the data
indicate bouncing of the tire after unloading. The simulated acceleration in the rear
frame, though also larger than the test data, was much closer to the expected values. The
difference in vehicle velocity is also clearly evident in the rear suspension data as the
simulation led the physical tests by approximately 0.2 seconds.
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9.5 Results: Improved Models
The large excitations in the suspension components observed in the baseline
model prompted the introduction of three modifications:
1. Addition of simple antiroll bar (ARB)
2. Scaled damper rates by a factor of two (no ARB)
3. Combined effects of ARB and increased damper rates
Suspension kinematics were compared against the test data for all three modifications, as
shown in Figures 9-13 through 9-16. To better compare the improvements in the rear
suspension behavior, the data for the simulation were offset to match the impact time
with the speed bump, though the response in the simulation is still slightly faster due to
the higher vehicle velocity.
The greatest improvement from these modifications is evident in the right-front
suspension behavior. The acceleration in the lower control arm was reduced from a peak
of over 6 g to a peak of just over 5 g, and the oscillations in the system damp out much
more quickly in all three cases. Total deflection was reduced approximately 5 mm from a
peak of 45 mm to less than 40 mm with the ARB. The ARB transfers a portion of the
forces from the right front suspension to the left, thus reducing the response on the right.
An initial compression of the left suspension due to body roll was created by adding the
ARB, but oscillations from the right tire bouncing were also transmitted to the left
suspension. The compression due to body roll more accurately matched the test data, but
the oscillations did not.
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Figure 9-13 - Front suspension acceleration data with model improvements.
Physical test data from NCAC [8].
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Figure 9-14 - Rear suspension acceleration data with model improvements. Physical
test data from NCAC [8].
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Figure 9-15 - Front suspension deflection with model improvements. Physical test
data from NCAC [8].

Figure 9-16 - Rear suspension deflection with model improvements. Physical test
data from NCAC [8].
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Increasing the damper rates without the ARB produced similarly less response in
the right suspension while not transferring additional forces to the left suspension. The
acceleration in the top suspension components was nearly unaffected by any of these
modifications, but showed accelerations reasonably within the range of the test data.
While the addition of the ARB did not significantly affect the rear suspension
behavior, stiffening the damper rates did produce results closer to the physical data. The
acceleration in the right rear bottom suspension were reduced from a peak of almost 7 g
to less than 5 g and the oscillations in the system were damped out much more quickly.
The left side still experienced unrealistically large accelerations when compared to the
test data, though these too were reduced and damped out quickly. Besides the remaining
large initial compression in the left rear suspension, the rear suspension deflections
showed very good agreement with the test data after stiffening the damper rates.
To reduce the right front suspension deflection to match that of the test data, the
front damper rates had to be scaled by 15. However, the suspension was then too stiff to
allow the proper rebound after the tire unloaded from the speed bump, as shown in
Figure 9-17. Thus, at least for striking small obstacles such as speed bumps or curbs,
scaling the damper rates by two produces the best results.
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Figure 9-17 - Front-right suspension deflection, high damper rates. Physical test
data from NCAC [8].

9.6 Discussion
Suspension reaction in the baseline model was of greater magnitude than was
observed in the physical test. Larger accelerations especially in the lower suspension
components led to larger suspension deflection. This was especially true of the right front
suspension which peaked at 45 mm compression compared to just 22 mm in the physical
test. This behavior can most likely be attributed to the inherent inability of the PAC 2002
tire model to accurately predict tire response when hitting an obstacle. The tire does not
deform in a similar fashion to the physical test contributing to the large suspension
deflections in the simulation. Further, the oscillations in the tire after unloading appear to
be exaggerated.
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Adding the ARB induced the slight body roll observed in the physical test, but
also introduced unrealistic oscillations in the left front suspension. The ARB model in
Adams/Car uses only a torsional spring in the middle of the ARB to transfer forces from
one side of the vehicle to the other. There is no damping added to the ARB model while
end link bushings likely provide some damping in the actual pickup suspension. For tests
involving small obstacles, the addition of the ARB as it is currently modeled does not
appear to significantly improve the response of the suspension.
Scaling the damper rates by two provided the best results, and did at least partially
mitigate the exaggerated response in the suspension due to the tire model. Stiffening the
suspension allowed the oscillations in the tire to dampen out much more quickly leading
to a more realistic behavior overall. Maximum suspension deflection, while still nearly
twice that of the physical test, was reduced approximately 5 mm. Increasing damper rates
beyond a scale factor of two did not significantly improve results. The damper scale
value which provides the best response is highly dependent on the test scenario being
considered, and is not the same between two different tests, as will be discussed in
Section 10.
In conclusion, the tire model is the most likely source of error in the speed bump
tests. According to information in Adams Help, the accuracy of the PAC 2002 model
breaks down when encountering obstacles with wavelengths smaller than the radius of
the tire. A highly nonlinear model called 'FTire' would likely provide much more
accurate results, but no such model was available for use in this study.
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10 V-DITCH BUMPER TRAJECTORIES
10.1 Introduction
In ongoing efforts to develop federal test standards for cable barriers placed on
sloped surfaces or in depressed medians, analysis of vehicle-to-barrier interface is crucial
to determining worst-case scenarios for underride and override [1,2]. Suggested test
matrices were developed based on finite element analysis (FEA) simulations of vehicle
trajectories when traversing V-ditch medians [3]. FEA, while able to model vehicle
impact with the barrier system, often requires many hours and sometimes days to run,
thereby limiting the number of scenarios that can be simulated [2]. Vehicle dynamics
analysis (VDA) using multibody systems (MBS) simulations provides a much more
efficient alternative for determining vehicle trajectories. NCAC research has utilized
HVE (Human Vehicle Environment, from The Engineering Dynamics Corporation)
[1,2,4,5,6].
Using the data from LS-Dyna simulations for validation [3], V-ditch trajectories
of the 2270P pickup were predicted using Adams/Car. The pickup enters the V-ditches at
an angle of 25 degrees and an initial velocity of 100 km/hr (62.1 mph) to match MASH
TL-3 conditions [20]. No drivetrain is included in the model. Slopes of 4H:1V and 6H:1V
are tested at a median widths of 24, 30, 38, and 46 ft. Following the convention
established in the previous work, a point on the left front bumper of the truck is traced to
represent the bumper height as the vehicle traverses the median. The location of this point
is shown in Figure 10-1. For these simulations, the ground is rigid. Adams/Car does
allow for the use of deformable soils but accurately modeling soils in V-ditches is beyond
the scope of this research.
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Figure 10-1 - Critical bumper point for trajectory traces.
With bushings included in the vehicle model, the front suspension failed and
folded into the body of the vehicle upon impact with the back slope of the ditches.
Therefore, all simulations are run with the front suspension in "kinematic mode"
removing the compliant bushings from all joints making them solid. Bumpstop forces are
increased to eliminate any suspension failure since studying such effects is not an
objective of this research.
The modeling guidelines for scaling the dampers are used in predicting the
trajectories. Based on the speed bump results, it was initially thought that a damping scale
factor of two would be sufficient for all scenarios. Thus for these simulations, the
"baseline" model refers to the case where the damping has already been scaled by a factor
of two. A damper scale factor of two is also required to prevent suspension failure upon
impacting the back slope. The "improved" case refers to the results from the final damper
scaling factor. Additionally, the effects of adding an antiroll bar are also studied.
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10.3 Damper Rate Effects for 6H:1V, 46ft Wide V-Ditch
Simulated trajectories are compared for the 2270P model traversing a 6H:1V
slope, 46 ft-wide V-ditch, as shown in Figure 10-2. Bumper heights at critical locations in
the ditch are summarized in Table 10-1. At this shallow depth, the effects of the ARB
were found to be insignificant; thus, it was not included in these simulations. The
baseline run, with a damping scale factor of two front and rear, showed very good
correlation with the LS-Dyna results except in the area of impact near the bottom of the
ditch.
As was observed during the speed bump tests, Adams/Car predicted slightly
higher suspension compression and thus lower minimum bumper heights upon impacting
the bottom of the ditch. However, this did not adversely affect the rebound on the back
slope which very closely matched the LS-Dyna simulations.
Though the overall behavior of the trajectory was satisfactory, a parameter study
focusing mainly on the front damper rates was conducted to obtain a better correlation in
the area near the bottom of the ditch. Scaling the front damper rates by 20 and the rear
dampers by 4 gave good results. The improved model very closely matched the minimum
bumper heights, as shown in Figure 10-2. However, the rebound on the back slope was
greatly reduced due to the dissipated impact energy and the slowed response of
suspension rebound.
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Figure 10-2 - 2270P bumper trajectories, 6H:1V, 46 ft wide V-ditch, damper
parameter study. LS-Dyna simulation from MwRSF [3].
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Table 10-1 - Critical Bumper Location Heights - 6H:1V, 46 ft Wide
Baseline Model
Critical Bumper Location

Improved Model

Adams
/Car

LSDynat

Error*
(%)

Adams
/Car

LSDynat

Error*
(%)

Improvement** (%)

Max. Height, Front Slope (in)
[Location from Front SBP (ft)]

34.4
[9.0]

35.3
[8.8]

2.55
[2.27]

34.6
[9.2]

35.3
[8.8]

1.98
[4.55]

-22.3
[+100.4]

Min. Height, Back Slope (in)
[Location from BD (ft)]

8.9
[4.8]

11.8
[5.2]

24.58
[1.42]

10.2
[4.9]

11.8
[5.2]

13.56
[1.06]

-44.8
[-25.4]

Max. Height, Back Slope (in)
[Location from Back SBP (ft)]

33.4
[8.2]

34.1
[6.0]

2.05
[5.50]

27.7
[8.5]

34.1
[6.0]

18.77
[8.62]

+815.6
[+56.7]

Height, 4 ft from Front SBP
(in)

31.7

32.7

3.06

31.3

32.7

4.28

+39.7

Max. Height, 0-4 ft from Back
SBP (in) [from Back SBP (ft)]

29.6
[4.0]

32.8
[4.0]

9.76
[0.0]

23.7
[4.0]

32.8
[4.0]

27.74
[0.0]

+184.2
[0.0]

* Location errors are with respect to the Front SBP (total displacement across ditch)
** Improvement indicates the relative change in error between the Baseline and Improved Adams/Car
models: (-) indicates a percentage reduction in error, (+) indicates a percentage increase in error.
t
LS-Dyna simulations from MwRSF [3].

Increasing damper rates decreased the error in the minimum bumper location on
the back slope to just 13.6% at the expense of under-predicting the rebound on the back
slope by 18.8%. Damper scale factors between 2 and 20 followed this same general
behavior. As the scale factor increased, minimum bumper height increased, and
maximum rebound height decreased. The trajectories reached a limit where the path did
not significantly change when increasing the damper scale factor higher than 20. None of
these intermediate values provided any better response.
Since crash tests and barrier designs rely on worst-case scenarios, the baseline
model would be most useful in this case. While it slightly exaggerates the suspension
deflection upon impact, it more accurately predicts the rebound on the back slope.
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Therefore, both worse-case scenarios are effectively demonstrated. For the remaining
6H:1V V-ditches, a damper scale factor of two is used front and rear.

10.4 Damper Rate Effects for 4H:1V, 46 ft Wide V-Ditch
As the ditch slope increases, the pickup does not impact the ditch until the back
slope, thus increasing the impact forces. The baseline model in this case severely overpredicts suspension deflection with the minimum bumper height actually extending
below ground level. Again, this is possible since the only contact between the tires and
the ground is calculated.
Unlike the 6H:1V case, the larger suspension deflection translated to higher
rebound heights as the suspension unloaded. A front damper rate parameter study was
conducted in an attempt to match the LS-Dyna results. The rear dampers were scaled by
four which kept the rear suspension closer to the back slope, as was predicted by the LSDyna simulations. In this case, the ARB tended to provide better results and was included
in the model for this parameter study.
High impact forces, large tire deformations, bumper interaction with the ground,
and deformable soils all play a factor in this scenario. As the front damper rates were
increased, the minimum bumper height was increased, and the rebound height was
decreased, as shown in Figure 10-3. There was a limit to these effects, and scaling the
front damper rates beyond 40 did not significantly alter the trajectory any further. Even at
this limit, negative bumper heights were still observed. Critical bumper heights are
summarized in Table 10-2.
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Figure 10-3 - 2270P bumper trajectories, 4H:1V, 46 ft wide V-ditch, damper
parameter study. LS-Dyna simulation from MwRSF [3].
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Table 10-2 - Critical Bumper Location Heights - 4H:1V, 46 ft Wide
Baseline Model

Improved Model

Critical Bumper Location

Adams
/Car

LSDynat

Error*
(%)

Adams
/Car

LSDynat

Error*
(%)

Improvement** (%)

Max. Height, Front Slope (in)
[Location from Front SBP (ft)]

44.4
[11.7]

46.0
[12.6]

3.27
[2.5]

44.8
[11.9]

46.0
[12.6]

2.60
[5.56]

-20.5
[+122.4]

Min. Height, Back Slope (in)
[Location from BD (ft)]

-9.8
[5.5]

2.4
[4.1]

508.3
[5.17]

-4.0
[5.0]

2.4
[4.1]

266.67
[3.32]

-47.5
[-35.8]

Max. Height, Back Slope (in)
[Location from Back SBP (ft)]

65.4
[0.0]

37.8
[7.4]

73.02
[19.17]

36.8
[4.3]

37.8
[7.4]

2.72
[8.03]

-96.3
[-58.11]

Height, 4 ft from Front SBP
(in)

35.6

36.7

3

35.3

36.7

3.8

+26.7

Max. Height, 0-4 ft from Back
SBP (in) [from Back SBP (ft)]

65.4
[0.0]

35.4
[4.0]

84.75
[9.52]

36.8
[4.0]

35.4
[4.0]

3.80
[0.0]

-95.5
[-100.0]

* Location errors are with respect to the Front SBP (total displacement across ditch)
** Improvement indicates the relative change in error between the unmodified and modified Adams/Car
models: (-) indicates a percentage reduction in error, (+) indicates a percentage increase in error.
t
LS-Dyna simulations from MwRSF [3].

It was determined that a front damper rate scale factor of 30 produced the best
results. Note that this scale factor is much higher than for the 6H:1V slopes where the
baseline model was deemed acceptable. Therefore, scenarios involving higher impact
forces will require much higher damping scale factors to compensate for inaccuracies in
the model. This is especially true in this case where bumper contact with the ground
becomes important.
The greatest reduction in error by using the improved model was observed in the
rebound on the back slope. The baseline model allowed very large suspension deflections
upon impact and the dampers absorbed little of the impact energy. The resulting rebound
was much higher than in the LS-Dyna simulations. Increasing the front damper rates by a
factor of 30 allowed the model to absorb much more of the impact energy, thereby
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reducing the bumper heights during rebound. Increasing the front damper rates beyond a
scale factor of 30 did not significantly improve the minimum bumper height and only
further reduced the bumper height on the back slope. Since bumper contact is not
accounted for in the Adams/Car model, contact does not occur until the tire hits the
ground. Thus, for steep slopes, it is impossible to eliminate negative bumper heights
completely. For the remainder of the 4H:1V V-ditches, the damper scale factors of 30 in
front and four in the rear are used.

10.5 Bumper Trajectories for 6H:1V V-ditches
Using a damping scale factor of two front and rear, simulated bumper trajectories
are compared for the 2270P traversing 6H:1V V-ditch medians with a widths of 24, 30,
38, and 46 ft as shown in Figures 10-4 through 10-7. Two Adams/Car simulations were
run at each width to determine the effects of adding the ARB: the first without the ARB
subsystem, the second with the ARB. Table 10-3 provides a summary of bumper heights
at multiple locations in the V-ditch. These values also provided a quantitative comparison
for the test data between the Adams/Car simulations and those done in LS-Dyna.
Overall, the Adams/Car simulation closely follows the LS-Dyna simulations
except for when the vehicle makes contact with the ground on the back slope. The
Adams/Car simulations predict slightly larger suspension deflection and lower minimum
bumper heights. However, the over deflection did not translate into increased rebound
heights on the back slope. Thus increasing damping rates would not significantly improve
the results. Since the vehicle remains close to the ground in these cases, the ARB appears
to have little to no effect on the dynamic behavior of the vehicle.
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As shown in the figures, the front tire penetrates the road surface rather than
deforming, again indicating a different tire model should be used. Further, only the tires
have contact with the ground. As shown in several of the figures, at minimum height the
bottom of the bumper penetrates the ground. The LS-Dyna simulations, however, specify
contact between the bumper and the ground eliminating this behavior. This demonstrates
a key difference between the FEA method and the MBS method. Since Adams/Car
performs all simulations assuming rigid body motion, the graphics of the pickup body are
for visual purposes only. The lack of contact between the bumper and ground also means
the vehicle does not dissipate any energy from deformation of the bumper.
In the relatively shallow 6H:1V medians, the inaccuracies due to impact with the
back slope are mitigated, as indicated by the overall good correlation between both
simulation methods. Less than 10% error in bumper height or locations were observed
with the exception of the minimum height on the back slope. The higher deflection of the
suspension did not create exaggerated rebound on the back slopes of the medians in
general. At the 38 ft width this behavior is slightly apparent, but still very good
agreement exists between simulations.
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Figure 10-4 - Critical Bumper Location Trajectories of 2270P pickup - 6H:1V VDitch, 24 ft Wide. LS-Dyna simulations from MwRSF [3].

134

Figure 10-5 - Critical Bumper Location Trajectories of 2270P pickup - 6H:1V VDitch, 30 ft Wide. LS-Dyna simulations from MwRSF [3].
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Figure 10-6 - Critical Bumper Location Trajectories of 2270P pickup - 6H:1V VDitch, 38 ft Wide. LS-Dyna simulations from MwRSF [3].
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Figure 10-7 - Critical Bumper Location Trajectories of 2270P pickup - 6H:1V VDitch, 46 ft Wide. LS-Dyna simulations from MwRSF [3].

Table 10-3 - Critical Bumper Location Heights - 6H:1V V-Ditches
24 ft
Critical Bumper Location

30 ft

38 ft

46 ft

Adams
/Car

LSDynat

Error*
(%)

Adams
/Car

LSDynat

Error*
(%)

Adams
/Car

LSDynat

Error*
(%)

Adams
/Car

LSDynat

Error*
(%)

Max. Height, Front Slope (in)
[Location from Front SBP (ft)]

34.4
[9.0]

35.3
[8.8]

2.55
[2.27]

34.4
[9.0]

35.3
[8.8]

2.55
[2.27]

34.4
[9.0]

35.3
[8.8]

2.55
[2.27]

34.4
[9.0]

35.3
[8.8]

2.55
[2.27]

Min. Height, Back Slope (in)
[Location from BD (ft)]

5.4
[6.4]

9.3
[2.7]

41.94
[25.17]

2.7
[5.7]

8.4
[4.9]

67.86
[4.02]

5.2
[4.5]

9.4
[4.2]

44.68
[1.29]

8.9
[4.8]

11.8
[5.2]

24.58
[1.42]

Max. Height, Back Slope (in)
[Location from Back SBP (ft)]

27.5
[0.0]

29.3
[0.0]

6.14
[0.0]

32.3
[0.3]

32.4
[0.5]

0.31
[0.68]

32.3
[3.2]

30.2
[2.5]

6.95
[1.97]

33.4
[8.2]

34.1
[6.0]

2.05
[5.50]

Height, 4 ft from Front SBP
(in)

31.7

32.7

3.06

31.7

32.7

3.06

31.7

32.7

3.06

31.7

32.7

3.06

Max. Height, 0-4 ft from Back
SBP (in) [from Back SBP (ft)]

27.5
[0.0]

29.3
[0.0]

6.14
[0.0]

32.3
[0.3]

32.4
[0.5]

0.31
[0.68]

32.3
[3.2]

30.2
[2.5]

6.95
[1.97]

29.6
[4.0]

32.8
[4.0]

9.76
[0.0]

SBP = Slope Break Point
BD = Bottom of Ditch
* Location errors are with respect to the Front SBP (total displacement across ditch)
**Adams/Car data is from the non ARB models. Good correlation between the bumper heights exist from both models for all widths.
t
LS-Dyna simulations from MwRSF [3].
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10.6 Bumper Trajectories for 4H:1V V-Ditches
As the slope becomes steeper, the vehicle travels further into the median before
contacting the ground, thus doing so with increased impact forces. Greater suspension
deflections are produced in 4H:1V V-ditches, as shown in Figures 10-8 through 10-11.
Critical bumper locations are summarized in Table 10-4. From the results of the damper
parameters study, these simulations were run with the dampers scaled by 30 in front, and
four in the rear.
In all four cases, the improved model gives reasonably good results when
compared to the LS-Dyna simulations. There still exists lower minimum bumper heights,
but the rebound behavior is well controlled. This is especially true for the 38 and 46 ft
widths. Less than 10% error exists in the predicted bumper heights, with the exception of
the minimum heights.
For the 24 and 30 ft widths, the maximum rebound heights are offset slightly in
the ditch due to the over-deflection of the suspension. Since bumper contact is not
accounted for in the Adams/Car model, the suspension must react before the vehicle will
rebound. The LS-Dyna simulations, which consider bumper impact, rebound more
quickly. This offset in the Adams/Car data explains the error in the rebound heights on
the back slope. As shown in the damper parameter study, it is not possible to completely
solve the minimum height issues by scaling damper rates.
These results suggest that using damping scale factors of 30 in the front and four
in the rear will produce reasonable results for 4H:1V V-ditches for any width between 24
and 46 ft. Here again, the effects of the ARB on trajectories in the ditch were largely
negated. However, in the baseline model, with its much higher rebound height, the
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addition of the ARB induced vehicle roll upon rebounding out of the 46 ft wide ditch.
Without physical testing, it is unclear which behavior is more accurate.

Figure 10-8 - Critical Bumper Location Trajectories of 2270P pickup - 4H:1V VDitch, 24 ft Wide. LS-Dyna simulations from MwRSF [3].
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Figure 10-9 - Critical Bumper Location Trajectories of 2270P pickup - 4H:1V VDitch, 30 ft Wide. LS-Dyna simulations from MwRSF [3].
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Figure 10-10 - Critical Bumper Location Trajectories of 2270P pickup - 4H:1V VDitch, 38 ft Wide. LS-Dyna simulations from MwRSF [3].
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Figure 10-11 - Critical Bumper Location Trajectories of 2270P pickup - 4H:1V VDitch, 46 ft Wide. LS-Dyna simulations from MwRSF [3].

Table 10-4 - Critical Bumper Location Heights - 4H:1V V-Ditches
24 ft

30 ft

38 ft

46 ft

Critical Bumper Location

Adams
/Car**

LSDynat

Error*
(%)

Adams
/Car**

LSDynat

Error*
(%)

Adams
/Car**

LSDynat

Error*
(%)

Adams
/Car**

LSDynat

Error*
(%)

Max. Height, Front Slope (in)
[Location from Front SBP (ft)]

45.1
[12.0]

45.9
[12.0]

1.74
[0.0]

45.1
[12.0]

46.0
[12.6]

1.74
[0.0]

45.0
[11.9]

46.0
[12.6]

2.17
[5.56]

44.8
[11.9]

46.0
[12.6]

2.60
[5.56]

Min. Height, Back Slope (in)
[Location from BD (ft)]

4.1
[7.4]

6.6
[7.1]

37.88
[1.57]

-0.5
[7.2]

5.7
[6.2]

108.77
[16.13]

-3.4
[6.3]

4.0
[5.1]

185.00
[4.98]

-4.0
[5.0]

2.4
[4.1]

266.67
[3.32]

Max. Height, Back Slope (in)
[Location from Back SBP (ft)]

25.3
[0.0]

32.4
[0.0]

21.91
[0.0]

32.1
[0.0]

37.0
[0.1]

13.24
[0.33]

34.9
[3.9]

37.9
[5.6]

7.92
[5.25]

36.8
[4.3]

37.8
[7.4]

2.72
[10.2]

Height, 4 ft from Front SBP
(in)

35.3

36.7

3.8

35.3

36.7

3.8

35.3

36.7

3.8

35.3

36.7

3.8

Max. Height, 0-4 ft from Back
SBP (in) [from Back SBP (ft)]

25.3
[0.0]

32.4
[0.0]

21.91
[0.0]

32.1
[0.0]

37.0
[0.1]

13.24
[0.33]

34.9
[3.9]

37.6
[2.5]

7.18
[3.94]

36.8
[4.0]

35.4
[4.0]

3.80
[0.0]

SBP = Slope Break Point
BD = Bottom of Ditch
* Location errors are with respect to the Front SBP (total displacement across ditch)
**Adams/Car data is from the non ARB models. Good correlation between the bumper heights exist for both models for 24 through 38 ft widths. The
rebound height at the 46 ft width is slightly reduced with the addition of the ARB.
t
LS-Dyna simulations from MwRSF [3].
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10.5 Summary
Analyzing vehicle dynamics when traversing depressed medians is critical to
establishing test standards for assessing the performance of highway median cable
barriers. MBS software, such as Adams/Car, has proven to be capable of predicting
bumper trajectories in V-ditches with limitations.
In shallow ditches with 6H:1V slopes, the baseline model showed good
correlation with previous LS-Dyna simulations completed at MwRSF [4] with the
exception of slightly over-predicting suspension deflection upon impact with the back
slope. This did not create excessive rebound on the back slope, however. Since bumper
contact is not significant for the pickup in 6H:1V slope ditches, Adams/Car modeling
could be reasonably relied upon to predict pickup trajectories in this case. It should be
noted that passenger cars with a lower ride height would likely experience significant
bumper contact with the ground resulting in body deformations, even in 6H:1V-sloped
ditches. Thus, the accuracy of MBS simulations would break down when considering
smaller vehicles.
In the steeper 4H:1V V-ditches, large tire deformations, bumper contact and body
deformation become very important for the pickup model. To compensate, the dampers
must be scaled by 30 in front and four in rear. These damper scale factors gave
reasonable results for ditch widths ranging from 24 to 46 ft. The model still over predicts
the minimum bumper height since bumper contact is not calculated in the Adams/Car
simulations. Further increasing the damper scale factors will never eliminate the
minimum bumper height behavior, as shown by the damper parameter study. This issue
presents one of the biggest hurdles MBS modeling must overcome before being able to
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accurately predict vehicle trajectories in steep depressed medians. Models created in
Adams/View do allow for custom contact definitions, and therefore may also be possible
in Adams/Car. Investigating custom contacts should be included in future research.
The damper parameter study proved that the inaccuracies in tire deformation can
be compensated for by increasing damper rates, especially in shallow ditches with lower
impact forces. However, the 4H:1V results show that no single damper rate will work for
all scenarios. A damper rate parameter study will be required for each test. Until the tire
models can be improved upon and bumper impact with the ground can be more
accurately modeled, MBS should not be relied upon to accurately predict vehicle
dynamics behavior where body deformations are significant, such as in 4H:1V or higher
slope V-ditches. Its use should be limited to 6H:1V or shallower slopes.
It is important to remember that these trajectories were compared against other
computer simulations, which by their nature are representative at best. No physical test
data was available to validate either model. The ability to predict bumper impact and
deformations gives FE modeling the competitive edge at this time, despite requiring
longer simulation times. MBS may prove useful in low-impact cases if time is a limiting
factor, and a general demonstration of how a vehicle might react is desired.
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11 SUMMARY AND CONCLUSIONS
This work provides a foundation for future multibody systems (MBS) simulations
to solve vehicle dynamics problems relating to roadside safety and the design of more
affective safety hardware systems. Adams/Car was used to create tutorials for performing
MBS vehicle dynamics simulations, build and validate a model to match the NCAC
Chevy Silverado, and predict trajectories of a pickup in 4H:1V and 6H:1V V-ditches with
widths of 24, 30, 38, and 46 ft.
An introduction to Adams/Car and MBS modeling was provided using the MDI
Demo Vehicle as a basis. Two main interfaces and a Post-Processor are included as part
of Adams/Car. The Template Builder interface allows creation and manipulation of
vehicle templates. The Standard Interface allows creation and manipulation of
subsystems and assemblies. All simulations are run from the Standard Interface as well.
The Post-Processor provides data plotting and simulation animation capabilities.
Vehicle model hierarchy was also introduced. Templates form the foundation of
any vehicle model and are used to define minor roles, basic geometry, parts, attachments,
forces, and communicators. Subsystems are built from existing templates but define
model-specific geometry; property files for forces, bushings and tires; part mass and
inertia properties; driveline activity; and kinematic modes (turning compliant bushings on
or off). Assemblies combine subsystems with an Adams/Car Testrig to form complete
models capable of running simulations.
Three simulations and related assignments were designed for teaching vehicle
dynamics modeling using the MDI Demo Vehicle in Adams/Car to demonstrate concepts
and methods presented by Gillespie [13]. Straight line acceleration tests introduced basic
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concepts of axle loads and longitudinal load transfer. Straight line braking tests expanded
on load transfer concepts while introducing braking gain and brake bias. A brake bias
parameter study provided an example of vehicle stability relating to both front wheel and
rear wheel lock up scenarios. It was shown that rear wheel lock up causes vehicle
instabilities as the simulation spun out during the maneuver. Constant-radius cornering
maneuvers introduced lateral load transfer and understeer, oversteer, or neutral steer
behavior. Steer angle versus velocity, lateral acceleration gain, and yaw velocity gain
plots demonstrated the understeer behavior of the MDI Demo Vehicle. Tire tests
introduced the relationship between side slip angle and lateral forces and how this
relationship was highly dependent on wheel loads.
Using the NCAC FE model of a Chevy Silverado for geometry and mass
properties [16], a 2270P-equivalent pickup model was created in Adams/Car using
mostly available templates and subsystems. The model was validated against full-scale
speed bump tests also performed by NCAC [8]. Simulations exhibited behavior similar to
the test data, however, utilizing a deformable tire model better suited for obstacle tests
would greatly improve the results. This model was then used to predict vehicle
trajectories in V-ditch medians.
Previous research suggests that the vehicle interface with cable barriers in
depressed highway medians is crucial for evaluating the performance of these systems
[1,2]. Previous work at NCAC, funded by the FHWA, used HVE software to predict
vehicle trajectories in V-ditch medians [1,2,4,5,6]. To expand on this work, vehicle
trajectories were predicted in V-ditches with 4H:1V and 6H:1V slopes and widths of 24,
30, 38, and 46 ft using the Adams/Car 2270P model. Previous LS-Dyna simulations at
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MwRSF of the same events were used for comparison [3]. In the shallower 6H:1V Vditches, the Adams/Car simulations showed good correlation with the FE results. The one
exception was the higher deflection of the front suspension upon impact with the back
slope as indicated by slightly lower minimum bumper heights. This was again attributed
to the lack of deformation available in the current tire model. These larger suspension
deflections did not result in excessive rebound after impact.
In the steeper 4H:1V V-ditches, however, the higher deflection of the suspension
was more pronounced, and negative critical bumper heights were even predicted.
Adams/Car does not account for contact between the bumper and ground, and cannot
predict vehicle body deformations. To compensate, the dampers were scaled by 30 in
front and four in the rear. These values produced reasonable results for widths of 24, 30,
38, and 46 ft. Since no full-vehicle tests were available for comparison with the simulated
V-ditch scenarios, the Adams/Car results must be considered representative, as were the
LS-Dyna results, until testing can be performed to better validate the models.
At this time, MBS modeling in Adams/Car should be used only to predict vehicle
dynamics behavior over relatively shallow (6H:1V or less) terrain and never for
predicting vehicle deformations. However, the standard Adams interface (Adams/View)
allows users to define custom contact definitions including those capable of dissipating
energy, and it may also be possible to include custom contacts in Adams/Car models.
Theoretically, such contacts would allow vehicles to begin redirecting before the
suspension system unloads and dissipate some energy relating to small body
deformations. If such contacts could eliminate or at least reduce the need to artificially
scale damper rates, the accuracy of steep-slope trajectories would be greatly improved.
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12 FUTURE RESEARCH
Three basic vehicle maneuvers were presented for use in learning vehicle
dynamics, yet there are many more options for maneuvers of increasing complexity in
Adams/Car. For example, suspension tests can be performed for investigating how roll
center heights can change with suspension deflection. More complex full-vehicle
maneuvers could also be analyzed such as braking-in-turn or a single lane change.
Multiple steering inputs are also available such as ramp steering or fish hook maneuvers.
Future research is required to test the use of better tire models. While scaling
damper rates can compensate for tire inaccuracies, a parameter study is required to
determine the best scale factors to use for each case. 'FTire' models produced by Cosin
Scientific Software [17] are much better suited for such simulations and are compatible
with Adams/Car. Licensing agreements are required to use these models and were not
available for this research. Deformable soil properties should also be incorporated in the
V-ditch simulations. Creating custom contact definitions between the bumper and ground
should also be investigated.
Rigid body dynamics were assumed for all simulations, though frame flex in the
2270P pickup could contribute to the dynamic behavior of the vehicle, especially in
impact events or opposite wheel travel suspension deflections. Flexible bodies can be
used in Adams/Car via the Adams/Flex add-on.
More complex areas of research could investigate the effects of driver inputs on
vehicle dynamics in crash test scenarios. For example, braking and steering inputs could
be incorporated into simulations for trajectories in V-ditch medians. Adams/Car allows
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for such inputs using the Event Builder where time-dependent driver inputs are defined
through mini-maneuvers.
It was concluded that changes to the 2270P pickup model are required before it
can be relied upon for predicting vehicle dynamics relating to roadside safety in a variety
of situations. This future research may be justified, however, as MBS has the ability to
perform fast simulations allowing for multiple test parameters to be investigated
relatively quickly, providing a distinct advantage over currently used FE simulations.

151

13 REFERENCES
1. Marzougui, D., Mohan, P., Mahadevaiah, U., and Kan, S., Performance
Evaluation of Low-Tension, Three-Strand Cable Median Barriers on Sloped
Terrains, FHWA/NHTSA National Crash Analysis Center Report (Submitted to
Federal Highway Administration), April 2007.
2. Marzougui, D., Kan, S., and Opiela, K., Evaluation of the Influences of Cable
Barrier Design and Placement on Vehicle to Barrier Interface, FHWA/NHSTA
National Crash Analysis Center Working Paper, October 2008.
3. Mongiardini, M., Faller, R., Rosenbaugh, S., and Reid, J., Test Matrices for
Evaluating Cable Median Barriers Placed in V-Ditches, Report Submitted to the
Midwest States Regional Pooled Fund Program, Transportation Research No.
TRP-03-265-12, Midwest Roadside Safety Facility, University of NebraskaLincoln, Lincoln, Nebraska, April 2, 2012.
4. Marzougui, D., Kan, S., Karcher, J., and Opiela, K., Using Vehicle Dynamics
Simulation as a Tool for Analyzing Cable Barrier Effectiveness, FHWA/NHSTA
National Crash Analysis Center Working Paper, August 2010.
5. Opiela, K., Marzougui, D., and Kan, S., Developing Functional (Design) and
Evaluation Requirements for Cable Median Barriers, FHWA/NHSTA National
Crash Analysis Center Working Paper, August 2010.
6. Marzougui, D., Kan, S., and Opiela, K., Vehicle Dynamics Investigations to
Develop Guidelines for Crash Testing Cable Barriers of Sloped Surfaces,
FHWA/NHSTA National Crash Analysis Center Working Paper, August 2010.
7. MD Adams, MSC.Software Corp., Santa Ana, CA, 2011,
<www.msc.software.com>
8. Mohan, P., Marzougui, D., Arispe, E., and Story, C., Component and Full-Scale
Tests of the 2007 Chevy Silverado Suspension System, FHWA/NHSTA National
Crash Analysis Center Report, July 2009.
9. MD R2 Adams/Car: ADM740 Course Notes, MSC.Software Corp., Santa Ana,
CA, June 2007.
10. MSC.Software Case Studies, <http://www.mscsoftware.com/Solutions/SuccessStories/?tid=2&apid=&inid=&pid=3&lid=>, accessed November 2012.

152
11. Deakin, A., Crolla, D., Ramirez, J., and Hanley, R., The Effect of Chassis Stiffness
on Race Car Handling Balance, SAE Technical Paper 200-01-3554, 2000,
doi:10.4271/2000-01-3554.
12. Amaral, C. and Neto, C., Validation of a Mathematical Model that Studies the
Critical Steering Angle for a Lateral Rollover on a Baja SAE Vehicle, SAE
Technical Paper 2011-36-0186, 2011, doi:10.4271/2011-36-0186.
13. Gillespie, T., Fundamentals of Vehicle Dynamics, Society of Automotive
Engineers (SAE) International, Warrendale, PA, February 1992.
14. Milliken, F.W. and Milliken, D.L., Race Car Vehicle Dynamics, Society of
Automotive Engineers (SAE) International, December 1994.
15. Blundel, M. and Harty, D., The Multibody Systems Approach to Vehicle
Dynamics, Elselvier, Ltd., Burlington, MA, 2004.
16. Finite Element Model of Chevy Silverado, Model Year 2007, Version 2,
FHWA/NHSTA National Crash Analysis Center, 2009
< http://www.ncac.gwu.edu/vml/archive/ncac/vehicle/silverado-v2.pdf>
17. Cosin Scientific Software, <http://www.cosin.eu/prod_FTire> accessed October
2012.
18. Jayakumar, P., Alanoly, J., and Johnson, R., "Three-Link Leaf-Spring Model for
Road Loads," SAE Technical Paper 2005-01-0625, 2005, doi:10.4271/2005-010625.
19. H.B. Pacejka, Tyre and Vehicle Dynamics, Butterworth-Heinemann, 2002, ISBN
0 7506 5141 5.
20. Manual for Assessing Safety Hardware (MASH), American Association of State
Highway and Transportation Officials (AASHTO), Washington, D.C., 2009.

153

APPENDIX A: ACCELERATION TUTORIAL
ADAMS/Car Introductory Tutorial: Straight-Line Acceleration
This tutorial shows how to open a demonstration vehicle model in ADAMS/Car
and perform a simple straight-line acceleration simulation.
1. To begin, click Start → All Programs → MSC.Software → MD R2 Adams → ACar
→ Adams-Car
ADAMS/Car will open with a small dialogue box. Make sure, if the option is
available, that 'Standard Interface' is selected. Click ‘OK.’
To change the background color, click Settings → View Background Color...

In the pop-up window, select one of the color options or create your own via the color
sliders at the bottom. The new color will appear in the right box at the top. Here white is
chosen. When finished, click 'OK.'
2. Open the demo vehicle by clicking File → Open → Assembly…
Right click inside the box titled ‘Assembly Name’ → Search →
<acar_shared>/assemblies.tbl

Select ‘MDI_Demo_Vehicle.asy’ and click ‘Open.’
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Click 'OK' in the Open Assembly window. After a few seconds, the model will
appear on the screen. Close the Message Window to begin working with the model.

3. Familiarize yourself with some of the basic view functions available. Right click
anywhere in the black area of the screen to display a menu of basic options. Try the
different view options as well as ‘Pan’ and ‘Zoom’ to understand how each works in
ADAMS/Car. ‘Front Iso’ puts the model back in the default view.
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Select the View dropdown menu → Render Mode and try the options available to see
how they change the appearance of the vehicle. Leave the model on either ‘Shaded’
or ‘Smooth Shaded.’ To make the car appear opaque, right click somewhere around
the top of the windshield and select ‘General Part: TR_Body.ges_chassis
→Appearance.

In the Edit Appearance box, change the Transparency from 60 to 0 and click OK.
Rotate the model to a slightly less aggressive angle.
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4. Simulate simple straight line acceleration by selecting the Simulate drop-down menu
→ Full-Vehicle Analysis → Straight-Line Events → Acceleration…

Fill in the information in the dialog box and click OK when finished. A Message
Window will appear listing the steps taken by the program as the simulation is run.
When it is finished, close this window.
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Adjust the view of your model if needed. To view an animation of the simulation,
select the Review drop-down menu → Animation Controls… The icons at the top
allow you to play, stop, or rewind the animation. The button furthest to the left resets
the animation at time zero. If you play the animation using the default settings, the
camera will stay fixed and the car will drive out of the screen.
To make the camera follow the vehicle, select the first drop-down menu in the
Animation Controls box →change to Base Part: → Right click in the text box that
appears → Body → Pick

Hover the cursor over the roof of the car and verify that ‘TR_Body.ges_chassis’
appears on the screen. Left-click to select the body of the car as the reference frame
for the camera. Run the animation again and watch how the car pitches up as it
accelerates. Also note how it pitches forward and backwards when the vehicle
changes gears.
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5. Perform some post-processing of the simulation to view quantitative results. Begin by
selecting the Review drop-down menu → Postprocessing Window…
The boxes at the bottom of the window allow the user to select the data to be
displayed. The ‘Simulation’ box allows you to select the name of the simulation you
are processing. Select different options in the ‘Request’ box and ‘Component box’
depending on the data you want to view. With a Component selected, click ‘Add
Curves’ to plot the data in the window. For example, select ‘tir_wheel_tire_forces’ in
the Request box, and ‘longitudinal_rear’ in the Component box. Click Add Curves to
view the following plot.

To add multiple curves to the same plot, leave the drop-down menu on ‘Add Curves
To Current’ and click Add Curves to add subsequent data to the plot. Click ‘Clear
Plot’ to clear the current displayed curves. Look at some of the various tire forces as
well. Decide if these plots match the expected behavior of the car in this simulation.
Try a few different versions of this simulation by going back to step 4 and changing
some of the parameters. Give these new simulations different names in the ‘Output
Prefix’ box to keep your results separate. Run the simulation again and compare the
results.
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APPENDIX B: ACCELERATION ASSIGNMENT
Homework A1 – Adams/Car
MECH 455/855 – Vehicle Dynamics – January 31, 2012
Utilize Adams/Car to simulate basic longitudinal vehicle maneuvers and compare the
results with hand calculations. For all hand calculations, assume the vehicle center of
mass does not have any lateral offset.
1. Run Adams/Car and load the full vehicle model MDI_Demo_Vehicle.
a. Simulate a full-vehicle test.
b. Find and record the total (right + left) front and rear normal tire forces for
the vehicle, also known as axle loads.
c. Find and record the total mass of the vehicle.
d. Find and record the x-locations of the center of mass and the front and rear
wheel center locations (default values in Adams/Car calculate all locations
from the origin).
e. Use values from 1.d. to calculate the wheelbase, and the x-location of the
CG relative to the axles (i.e., lengths 'b' and 'c' as denoted in Gillespie
book).
f. Perform hand calculations using results from 1.c. and 1.d. to confirm the
static axle loads found in 1.b. Note any discrepancies.
2. Using the default vehicle, run an acceleration test using the following parameters:
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a. Perform hand calculations using a longitudinal acceleration of 0.25 g's to
find the axle weights under these conditions. Calculate the longitudinal
load transfer.
b. Plot the right side normal tire forces for the front and rear on the same
plot. Be sure to give your plot a title. Find values for the front and rear tire
normal forces under acceleration and compare to the hand calculations
made in part 2a.
c. State reasons for any discrepancies.
3. Modify the model so that the center of mass height for the part
TR_Body.ges_chassis is vertically increased # mm. (see below for #)
a. Using the modified model, run the acceleration test again from part 2.
b. Plot the normal forces for the right side rear tire from both acceleration
tests on the same plot. Don't forget to add a title.
c. Explain the differences between the two data sets.
d. Calculate the axle weights and longitudinal load transfer for the modified
vehicle simulation.
# = height to raise CG in millimeters
This value should be between 75 and 150 mm. Use the last 2 numbers of your UNL
student ID number. If that is not between 75 and 150 mm, then double that number.
Repeat until it is.
Teams: Work individually on this assignment. Each person should have their own
experience with Adams.
Due Date: Tuesday, February 7, 2012, 8:00 am
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APPENDIX C: BRAKING ASSIGNMENT
Homework A2 – Adams/Car
MECH 455/855 – Vehicle Dynamics – February 9, 2012
Utilize Adams/Car to simulate a basic longitudinal braking vehicle maneuver then
perform a parametric study focusing on brake bias. For all hand calculations, assume the
vehicle center of mass does not have any lateral offset.
4. Run Adams/Car and load the full vehicle model MDI_Demo_Vehicle. Change the
operating units to English units. Select Settings → Units... and select the IPS
button near the bottom of the Units Settings window. Make note of the units now
being used by Adams/Car. Hit 'OK' to keep these units.
5. First simulate a full-vehicle straight-line braking test to investigate some of the
basic concepts of this maneuver. This will simulate a slight deceleration from a
constant initial highway speed (i.e. slowing down before a turn on an exit ramp).
Use the following parameters:

The Start Time specifies when the maneuver will begin, the Final Brake input
specifies a force which will be applied to the brake pedal by the driver (see note),
and the Duration of Step states the time (in seconds) over which the brake input
increases from zero to the final specified value.
NOTE: There is an apparent glitch in the program when operating in English
units and utilizing the 'Open-Loop Brake' function. When running braking
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simulations in metric units, the program returns a brake pedal force equal to the
'Final Brake' input in newtons. In English units, however, the program apparently
attempts to convert from newtons to lbf, but somehow applies the conversion
backwards. For instance, while operating in English units, entering a Final Brake
value of '1' will return a brake force of 4.4482 lbf. This is actually the inverse of
the conversion from newtons to lbf. This issue could not be remedied, so use the
values shown to obtain the required values. The Final Brake value shown above
should return a brake pedal force of 5 lbf. Verify this in the PostProcessor after
running the simulation. First make sure Source is set to Result Sets. Then plot:
Result Set: expand 'testrig' and select 'driver_demands' → Component: 'brake.'
6. Post-process the results of the simulation by plotting the following:
a. The brake torques for all four wheels on the same plot.
b. The vehicle (chassis) longitudinal acceleration.
c. Vertical tire loads for all four tires on the same plot.
d. Longitudinal tire loads for all four tires on the same plot.
e. Record the brake line pressures after 2.0 seconds for the front and rear.
Use these values and the brake torques found in 3a (after 2.0 seconds) to
calculate the brake gain for the front and rear brakes (in-lb/psi).
f. Refer to the plot from part 3b. Does the vehicle longitudinal acceleration
remain constant after 2.0 seconds? Why or why not? (Explain the
simulation behavior physically)
7. Perform a parametric study to explore the effects of changing the brake bias in the
model. This question will simulate a driver traveling on the interstate who quickly
slams on the brakes to avoid an object in the road.
To adjust the front brake bias, select the Adjust drop-down menu → Parameter
Variable → Table... The Parameter Variable Modification Table should appear.
Select 'MDI_Demo_Vehicle.TR_Brake_System' in the drop-down menu. The first
parameter should be the front brake bias. This value can be varied from 0 to 1.0,
with 0.6 being the default setting. This means the brake bias is set to 60% to the
front, 40% to the rear. Changing the front brake bias automatically changes the
rear bias accordingly.
a. Using the default vehicle parameters, run a straight-line braking
simulation with the following parameters:
Simulation time length = 5.0 seconds
Number of Steps = 500
Initial velocity = 75 mph
Begin braking after 0.5 seconds
Final brake force = max value = 22.4 lbf* (enter 5.0357) applied in 0.2
seconds
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b.

c.
d.
e.

Change the Steering Input to 'locked.' This will not allow for driver
steering inputs so the uncorrected vehicle behavior can be analyzed. (i.e.
the driver panics and just hangs onto the steering wheel without steering)
Increase the front brake bias value by 0.05 and rerun the simulation from
4a. Use the Postprocessor to determine if the front wheels locked-up
during the simulation. (Hint: 'til_wheel_tire_rolling_states'
'omega_actual_front') If they did not, increase the front brake bias by
another 0.05, rerun the simulation, and Postprocess the results. Continue
doing so until you have located the first front brake bias value which
causes the front wheels to lock-up and remain locked-up under these
conditions. Record this value.
Repeat 4b, this time decreasing the front brake bias by increments of 0.05
until you have located the first value that causes the rear wheels to lockup. Record this value.
On the same plot, show the chassis longitudinal velocities for the first
front wheel lock-up simulation, the first rear wheel lock-up simulation,
and the default vehicle simulation.
According to the results from this simulation, which appears to be the
more dangerous situation, front wheel lock-up or rear wheel lock-up, in
terms of vehicle behavior and stability? Explain. Provide at least one data
plot which supports your answer.

Suggested additional study: When running computer simulations of any model, one
must verify that the results being obtained are reasonable and accurate. Perform a
few hand calculations to verify your results. The following questions refer to the
simulation done in question number 2. For all questions use data at 3.0 seconds
into the simulation.
a. Record the longitudinal chassis acceleration. Use this to hand-calculate the
longitudinal load transfer. Compare to the vertical tire forces from the
simulation. Explain any discrepancies.
b. Find the rolling radius of the left side front tire. Using the rolling radius
and brake torque found in 2a, calculate the brake force on this tire (Eq. 331 in the textbook). Compare with the longitudinal tire force found in 2d.
Explain any discrepancies.
c. Use all relevant variables in equation 3-1 to confirm that the chassis
acceleration was computed correctly.
Teams: Work individually on this assignment. Each person should have their own
experience with Adams.
Due Date: Tuesday, February 16, 2012, 8:00 am
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APPENDIX D: TIRE TEST RIG TUTORIAL
Tire Testrig
Introduction
This tutorial introduces the Tire Testrig in Adams/Car, which performs virtual tire
testing comparable to physical test stands used by many tire companies. Access the Tire
Testrig in the standard interface by selecting Simulate → Component Analysis → Tire
Testrig... The testrig interface will open. Select File → New and enter the name
"pure_cornering" and hit Enter. Now the interface should create a new tire test with no
inputs, as shown in Figure 1.

Figure D-1 - Tire Testrig interface upon creating a new analysis file.
At this point, only one analysis (currently named "analysis_1") exists. Selecting the arrow
to the left of the name displays a list of current analyses in the tire analysis file. In this
window, the solver parameters are given for each analysis and can be modified if desired.
First select "Analysis_1" to highlight the line, then right click on the name again. This
brings up a menu of options: Copy, Paste, Rename, Delete, and Modify with
PropertyEditor. Select "Rename" and title the first analysis "TR_front." Right click the
modified name and select Modify with PropertyEditor to return to the first window,
shown in Figure 1, except with the new name.
Click through the tabs in the middle of the window to see the parameters available
in each one. Click the "Tire" tab, and select the small folder icon to the right of the
"Property File" text box to open the Select File Window, as shown in Figure __. The
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main window will initially show the contents of the currently selected working directory.
In the top left box are a list of Registered Databases in the current settings of Adams/Car.
Select "mdids://acar_shared/" to open a list of all available tire properties in the shared
database. Select "TR_front_pac89.tir" and click Open.

Figure D-2 - Select File window.
Next, change the mass and inertia properties to match the MDI Demo Vehicle
front wheel:




Mass = 25.0 kg
Ixx = Iyy = 0.8 kg-m2
Izz = 1.0 kg-m2

The default "Road" inputs will be used, so select the "Kinematics" tab. Only the
tire radius will be changed, accomplished by selecting the "Load from File" button. Click
the "Vertical/Longitudinal" tab and change the static load to match the front axle weight
of the MDI Demo Vehicle (3152.09 N). Leave the "Out of Plane" tab unmodified, but
note that the analysis specifies a slip angle sweep of +/- 15º. Also leave the "Spring
Damper" tab unmodified.
Now all inputs have been completed for the first analysis in the file. To save the
work accomplished, select "Save As" and select the desired file location (suggestion: use
a personally-created database for files such as this).
Select the arrow to the left of the analysis name and add another analysis file
named "TR_rear." Type the name in the text box near the bottom and select "Add."
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Follow the same procedures as before, with the exception of the following inputs which
are specific to the rear wheels on the MDI Demo Vehicle:



Tire Property File: TR_rear_pac89.tir
Static Load: 4338.63

Save the file, then click "Run It." A command prompt window will open to
indicate the solver has begun running the analysis. An information window will appear to
notify the analysis is complete. The postprocessor will open automatically with several
plots listed in the tree menu on the left. Click through these plots to see what information
is contained in each.
Select "page_tire_lateral_force_sa" to view the lateral force vs. slip angle
behavior for the two tires, as shown in Figure __. Determine cornering stiffness values
for both tires in the linear range about 0.
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APPENDIX E: CORNERING ASSIGNMENT
Homework A3 – Adams/Car
MECH 455/855 – Vehicle Dynamics – February 9, 2012
Utilize Adams/Car to simulate a full-vehicle cornering event and investigate the changes
in handling response by changing the tire properties and CG location. Perform virtual tire
tests and compare to the full-vehicle test results through post-processing and the use of
methods shown in the text book.
1. Run Adams/Car and change the operating directory to a personal folder by
selecting File → Select Directory
2. Open the Tire Testrig by selecting Simulate → Component Analysis → Tire
Testrig... Follow the step-by-step instructions in the Tire Testrig Tutorial to set up
the test for this assignment. Convert results to English units using the postprocessor or a spreadsheet.
a. Find and record the cornering stiffness for the front and rear tires via
linear approximation for small slip angles.
NOTE: There have been more strange results found when operating in IPS units,
so the default setting of MMKS units will be used for all Adams/Car simulations
in this assignment. You will be asked to export certain data sets into an Excel
document and convert to English units later. This will allow the use of the
equations used in the textbook, which are defined in English units.
3. Simulate a full-vehicle, constant-radius turn. Select Simulate → Full-Vehicle
Analysis → Static and Quasi-Static Maneuvers → Constant Radius Cornering...
Enter the following information:
Output Prefix: HW_A3
Number of Steps: 100
Simulation Mode: interactive (default)
Road Data File: (default)
Turn Radius: 100 m
Final Lateral Accel (G's): 0.8
*Leave 'Desired Long Acc (G's)' and 'Bank Angle' blank
This creates a simulation where the vehicle will follow a wide, 100 m radius turn
accelerating in turn until a maximum lateral acceleration of 0.8 G's is obtained.
This simulation uses quasi-static modes to compute this maneuver which runs
faster but does not allow for a very detailed animation video (try viewing the
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animation). We are concerned with analyzing the data, so a video in this case is
not important.
4. Post-process the results of the simulation by first exporting the following data,
then scaling from metric to English units:
a. The vehicle steering wheel angle vs. longitudinal velocity. Plot
steering_displacements → angle_front (dependent) vs. chassis_velocities
→ longitudinal (Independent Axis).
b. The lateral tire force vs. lateral slip angle (Independent Axis) for all four
tires.
c. The normal tire forces vs. lateral acceleration for all four tires.
d. Vehicle side slip angle vs. longitudinal velocity.
e. Lateral acceleration vs. time
f. Yaw velocity vs. time
g. Steer angle vs. time
h. Longitudinal velocity vs. time
5. Complete the following steps.
a. Find and record the Ackerman angle. Scale the data from 4.a. by the
Ackerman angle, so the steer angle represents that at the front tires rather
than at the steering wheel. (scale 4.g. in the same manner). Plot the steer
angle vs. velocity.
b. Determine if the vehicle exhibits neutral steer, oversteer, or understeer
behavior.
c. Find the characteristic or critical speed (whichever is applicable).
d. Use your answer from 5.c. to find a value for the Understeer Gradient, K.
e. Assuming the Understeer Gradient is constant, plot the theoretical steer
angle, δ (Eq. 6-16) with the Adams results on the same graph.
f. Plot the lateral acceleration gain vs. velocity. Use the equation in the text
to include a curve for the neutral steer case. Discuss the data.
g. Plot the yaw velocity gain vs. vehicle velocity. Again, also include a curve
for the neutral steer case. Discuss the data.
6. Answer the following questions:
a. Do the Adams results indicate a constant Understeer Gradient, K?
b. Using the results from the tire test, 2.a, calculate Ktires.
c. Does 6.b. agree with 5.d? Why or why not?
d. Would the bicycle model be a good approximation for this test?
Teams: Work individually on this assignment. Each person should have their own
experience with Adams.
Due Date: Tuesday, February 16, 2012, 8:00 am
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APPENDIX F: 2270P MODEL DATA
Hardpoint locations shown in Figures F-1 through F-5 are summarized in Tables
F-1 through F-4. Mass and inertia properties for major components are summarized in
Table F-5.

Figure F-1 - 2270P body subsystem front hardpoints.

Figure F-2 - 2270P body subsystem rear hardpoints.
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Table F-1 - 2270P Body Hardpoint Locations
HP Name
hpl_front_strut_accelerometer
hpl_front_strut_stringpot

x (mm)
335.04
607.73

y (mm)
-477.72
-508.95

z (mm)
635.33
731.91

hpl_front_wheel_center
hpl_rear_accelerometer
hpl_rear_frame_stringpot

525.84
4154.56
4157.28

-882.86
-465.04
-542.2

396.44
742.49
744.24

hpl_rear_wheel_center
hps_bumper_marker
hps_path_reference

4170.68
-172.31
0

-848.69
-951.94
0

396.44
660.52
0

Figure F-3 - 2270P front suspension hardpoints.

Notes
NCAC test report [8]
NCAC test report [8]
(see notes in suspension
tables)
NCAC test report [8]
NCAC test report [8]
(see notes in suspension
tables)
MwRSF report [3]
Adams/Car default

Table F-2 - 2270P Front Suspension Hardpoint Locations
HP Name
hpl_drive_shaft_inr
hpl_front_lca_accel
hpl_front_lca_stringpot
hpl_lca_front
hpl_lca_outer
hpl_lca_rear
hpl_lwr_strut_mount
hpl_subframe_front
hpl_subframe_rear
hpl_tierod_inner
hpl_tierod_outer
hpl_top_mount
hpl_uca_front
hpl_uca_outer
hpl_uca_rear
hpl_wheel_center

x (mm)

y (mm)

z (mm)

326.81
598.12
263.42
508.25
693.57
478.15
262.05
706.25
348.14
372.72
467.65
331.14
536.23
612.95
525.84

-501.37
-558.52
-339.35
-792.4
-341.14
-606.51
-400.53
-400.54
-387.29
-783.23
-492.73
-481.62
-733.38
-483.96
-882.86

297.84
325.67
312.94
292.37
323.25
330.98
465.19
440.76
404.83
407.68
737.81
565.93
546.26
532.5
396.44

Nodes used* Notes
None in model (2x4)
2857326
2859019
2530549, 2530547
2530561
2530545, 2530543
2538085, 2538076
2332540 node on frame near lower control arm front mounting bracket
2336832 node on frame near lower control arm rear mounting bracket
2689988
2689989
2534490
2530551, 2530553
2530559
2530555, 2530557
2530565, 2530563 y-location approximated by nodes on the face of brake rotor

*Node numbers are from NCAC FE model [16]
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Figure F-4 - 2270P rear suspension hardpoints.
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Table F-3 - 2270P Rear Suspension Hardpoint Locations
HP Name
hpl_accelerometer_location
hpl_axle_tube_outer
hpl_front_leaf_eye
hpl_front_torsional_joint
hpl_jounce_at_axle
hpl_jounce_at_frame
hpl_leaf_spring_to_shackle
hpl_pseudo_steer_axis
hpl_rear_torsional_joint
hpl_second_stage_on_axle
hpl_second_stage_on_frame
hpl_shackle_to_frame
hpl_shock_lower
hpl_shock_upper
hpl_stringpot_loc
hpl_wheel_center

x (mm)
4170.68
4170.68
3351.73
3923.21
4172.1
4162.57
4936.61
4330
4396.71
4172.1
4169.08
4950.28
4274.77
4443.21
4170.68
4170.68

y (mm)
-418.69
-773.36
-619.62
-622.04
-501.17
-501.67
-627.13
-860
-624.91
-623.48
-623.48
-626.77
-489.38
-374.86
-538.69
-848.69

z (mm)
441.44
396.44
506.09
490.77
445.06
631.17
729.36
440
557.76
378
437
617.58
283.67
800.13
441.44
396.44

hpr_shock_lower
hpr_shock_upper

4107.72
3862.26

488.51
373.97

258.04
785.73

Nodes used* Notes
2689835, 2927740
2530045, 2530047
location found from SAE methods [18]
2939834
2349303
2530037, 2530039
proportionate to wheel center location
location found from SAE methods [18]
define helper spring engagement (approx location)
define helper spring engagement (approx location)
2530041, 2530043
2530567
2530570
2689835, 2689834 nodes 2937494, 2936937 used for y-coord. -878.86
ave y based on other two nodes
2530568
2530569

*Node numbers are from NCAC FE model [16]
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Figure F-5 - 2270P steering subsystem hardpoints.

Table F-4 - 2270P Steering Subsystem Hardpoint Locations
HP Name
hpl_rack_house_mount
hpl_tierod_inner
hps_intermediate_shaft_forward
hps_intermediate_shaft_rearward
hps_pinion_pivot
hps_steering_wheel_center

x (mm)
348.14
348.14
533.25
809.09
348.14

y (mm)
-337.29
-387.29
-342.61
-578.92
-139.29

z (mm)
404.83
404.83
729.06
881.1
404.83

1500

-578.92

1300

*Node numbers are from NCAC FE model [16]

Nodes used* Notes
2689988
2415104
2038346
2483303,
2483176
approx.

Table F-5 - 2270P Major Part Mass and Inertia Properties*
Part name

Mass
(kg)

Ixx
(kg/mm2)

Iyy
(kg/mm2)

Izz
(kg/mm2)

Ixy
(kg/mm2)

Iyz
(kg/mm2)

Ixz
(kg/mm2)

CG location (x,y,z)
(mm, mm, mm)

body & chassis & drivetrain
front lwr control arm
front spindle
front subframe
front sway bar
front uppr control arm
front wheel + brake rotor
leaf spring
leaf shackle
rear axle + brake drum
rear wheel
steering rack

1789.90
10.50
11.70
22.06
6.14
2.54
56.10
24.81
0.65
158.49
44.20
12.40

7.24E+08
1.58E+05
9.08E+04
1.65E+06
8.70E+05
2.09E+04
2.58E+06
1.30E+05
2.24E+03
5.67E+07
2.54E+06
6.08E+05

4.17E+09
1.45E+05
1.06E+05
1.13E+06
6.29E+04
3.02E+04
4.47E+06
4.70E+06
7.02E+02
4.06E+06
8.46E+06
2.20E+04

4.45E+09
2.98E+05
6.10E+04
2.55E+06
9.23E+05
4.92E+04
3.68E+06
4.59E+06
1.70E+03
5.96E+07
7.87E+06
5.99E+05

1.17E+07
-5.69E+01
-2.17E+01
-2.69E+04
2.21E+03
5.02E+03
-8.43E+05
2.32E+04
-1.23E-01
7.22E+04
1.96E+06
-1.19E+04

2.92E+06
-4.27E+03
-7.66E+03
8.33E+03
1.85E+03
1.93E+03
-7.88E+04
3.48E+03
-1.31E+00
1.89E+04
-9.27E+04
-7.61E+03

-7.58E+07
-5.04E+03
-7.02E+03
7.51E+04
1.58E+04
2.48E+03
-1.07E+05
-6.23E+05
1.24E+02
1.39E+05
2.57E+05
-2.44E+02

1899.95, 13.1465, 820.592
499.512, -578.486, 303.155
519.398, -826.921, 390.109
427.09, -6.66565, 364.195
804.001, 11.7575, 357.968
501.037, -600.268, 559.854
678.628, -770.513, 410.53
4152.75, -623.516, 531.065
4944.22, -627.115, 700.387
4054.96, 1.54029, 398.643
4171.92, -859.779, 396.26
357.634, 24.2844, 408.971

full vehicle

2269.67

1.05E+09

6.03E+09

6.49E+09

1.51E+07

1.01E+06

3.38E+07

2060.43, 10.5118, 735.278

*Properties taken from NCAC FE model [16]
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